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A.0 Disclaimer / Standard Warranty

CE certification
The equipment listed as CE certified means that the product complies with the essential requirements concerning safety and
hygiene. The European directives that have been taken into consideration in the design are available on written request to
ADB SAFEGATE.

ETL certification
The equipment listed as ETL certified means that the product complies with the essential requirements concerning safety and
C22.2 No.180:13 (R2018) regulations. The CSA directives that have been taken into consideration in the design are available
on written request to ADB SAFEGATE.

All Products Guarantee
ADB SAFEGATE will correct by repair or replacement per the applicable guarantee below, at its option, equipment or parts
which fail because of mechanical, electrical or physical defects, provided that the goods have been properly handled and
stored prior to installation, properly installed and properly operated after installation, and provided further that Buyer gives
ADB SAFEGATE written notice of such defects after delivery of the goods to Buyer. Refer to the Safety section for more
information on Material Handling Precautions and Storage precautions that must be followed.

ADB SAFEGATE reserves the right to examine goods upon which a claim is made. Said goods must be presented in the same
condition as when the defect therein was discovered. ADB SAFEGATE furthers reserves the right to require the return of such
goods to establish any claim.

ADB SAFEGATE's obligation under this guarantee is limited to making repair or replacement within a reasonable time after
receipt of such written notice and does not include any other costs such as the cost of removal of defective part, installation
of repaired product, labor or consequential damages of any kind, the exclusive remedy being to require such new parts to be
furnished.

ADB SAFEGATE's liability under no circumstances will exceed the contract price of goods claimed to be defective. Any returns
under this guarantee are to be on a transportation charges prepaid basis. For products not manufactured by, but sold by ADB
SAFEGATE, warranty is limited to that extended by the original manufacturer. This is ADB SAFEGATE's sole guarantee and
warranty with respect to the goods; there are no express warranties or warranties of fitness for any particular purpose or any
implied warranties of fitness for any particular purpose or any implied warranties other than those made expressly herein. All
such warranties being expressly disclaimed.

Standard Products Guarantee
Products manufactured by ADB SAFEGATE are guaranteed against mechanical, electrical, and physical defects (excluding
lamps) which may occur during proper and normal use for a period of two years from the date of ex-works delivery, and are
guaranteed to be merchantable and fit for the ordinary purposes for which such products are made.

FAA Certified products manufactured by ADB SAFEGATE
ADB SAFEGATE L858 Airfield Guidance Signs are warranted against mechanical and physical defects in design or manufacture
for a period of 2 years from date of installation, per FAA AC 150/5345-44 (applicable edition).

ADB SAFEGATE LED products (with the exception of obstruction lighting) are warranted against electrical defects in design or
manufacture of the LED or LED specific circuitry for a period of 4 years from date of installation, per FAA EB67 (applicable
edition). These FAA certified constant current (series) powered LED products must be installed, interfaced and powered with
and through products certified under the FAA Airfield Lighting Equipment Program (ALECP) to be included in this 4 (four) year
warranty. This includes, but is not limited to, interface with products such as Base Cans, Isolation Transformers, Connectors,
Wiring, and Constant Current Regulators.

Note
See your applicable sales agreement for a complete warranty description.

Replaced or repaired equipment under warranty falls into the warranty of the original delivery. No new warranty period
is started for these replaced or repaired products.
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Liability

WARNING

Use of the equipment in ways other than described in the catalog leaflet and the manual may result in personal
injury, death, or property and equipment damage. Use this equipment only as described in the manual.

ADB SAFEGATE cannot be held responsible for injuries or damages resulting from non-standard, unintended uses of its
equipment. The equipment is designed and intended only for the purpose described in the manual. Uses not described in the
manual are considered unintended uses and may result in serious personal injury, death or property damage.

Unintended uses, includes the following actions:

▪ Making changes to equipment that have not been recommended or described in this manual or using parts that are not
genuine ADB SAFEGATE replacement parts or accessories.

▪ Failing to make sure that auxiliary equipment complies with approval agency requirements, local codes, and all
applicable safety standards if not in contradiction with the general rules.

▪ Using materials or auxiliary equipment that are inappropriate or incompatible with your ADB SAFEGATE equipment.

▪ Allowing unskilled personnel to perform any task on or with the equipment.

Copyright Statement
This manual or parts thereof may not be reproduced, stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, recording, nor otherwise, without the author's prior written consent.

This manual could contain technical inaccuracies or typographical errors. The author reserves the right to revise this manual
from time to time in the contents thereof without obligation of the author to notify any person of such revision or change.
Details and values given in this manual are average values and have been compiled with care. They are not binding, however,
and the author disclaims any liability for damages or detriments suffered as a result of reliance on the information given
herein or the use of products, processes or equipment to which this manual refers. No warranty is made that the use of the
information or of the products, processes or equipment to which this manual refers will not infringe any third party's patents
or rights. The information given does not release the buyer from making their own experiments and tests.

Note
See your sales order contract for a complete warranty description.

Replaced or repaired equipment under warranty falls into the warranty of the original delivery. No new warranty period
is started for these replaced or repaired products.
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1.0 Safety

Introduction to Safety
This section contains general safety instructions for installing and using ADB SAFEGATE equipment. Some safety instructions
may not apply to the equipment in this manual. Task- and equipment-specific warnings are included in other sections of this
manual where appropriate.

1.1 Safety Messages

HAZARD Icons used in this manual
For all HAZARD symbols in use, see the Safety section. All symbols must comply with ISO and ANSI standards.

Carefully read and observe all safety instructions in this manual, which alert you to safety hazards and conditions that may
result in personal injury, death or property and equipment damage and are accompanied by the symbols shown below.

WARNING

Failure to observe a warning may result in personal injury, death or equipment damage.

DANGER – Risk of electrical shock or ARC FLASH

Disconnect equipment from line voltage. Failure to observe this warning may result in personal injury, death, or
equipment damage. ARC Flash may cause blindness, severe burns or death.

WARNING – Wear personal protective equipment

Failure to observe may result in serious injury.

WARNING – Do not touch

Failure to observe this warning may result in personal injury, death, or equipment damage.

CAUTION

Failure to observe a caution may result in equipment damage.

ELECTROSTATIC SENSITIVE DEVICES

This equipment may contain electrostatic devices.

Qualified Personnel

Important Information

The term qualified personnel is defined here as individuals who thoroughly understand the equipment and its
safe operation, maintenance and repair. Qualified personnel are physically capable of performing the required
tasks, familiar with all relevant safety rules and regulations and have been trained to safely install, operate,
maintain and repair the equipment. It is the responsibility of the company operating this equipment to ensure
that its personnel meet these requirements.

Always use required personal protective equipment (PPE) and follow safe electrical work practice.
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1.1.1 Introduction to Safety

Additional Reference Materials

Important Information

▪ IEC – International Standards and Conformity Assessment for all electrical, electronic and related
technologies.

▪ IEC 60364 – Electrical Installations in Buildings.

▪ CSA – C22.2 No.180:13 (R2018), series isolating transformers for airport lighting.

▪ FAA Advisory: AC 150/5340-26 (current edition), Maintenance of Airport Visual Aid Facilities.

▪ Maintenance personnel must refer to the maintenance procedure described in the ICAO Airport Services
Manual, Part 9.

▪ ANSI/NFPA 79, Electrical Standards for Metalworking Machine Tools.

▪ National and local electrical codes and standards.

1.1.2 Intended Use

CAUTION
Unsafe Equipment Use
This equipment may contain electrostatic devices, hazardous voltages and sharp edges on components

• Read installation instructions in their entirety before starting installation.
• Become familiar with the general safety instructions in this section of the manual before installing,

operating, maintaining or repairing this equipment.
• Read and carefully follow the instructions throughout this manual for performing specific tasks and

working with specific equipment.
• Make this manual available to personnel installing, operating, maintaining or repairing this

equipment.
• Follow all applicable safety procedures required by your company, industry standards and

government or other regulatory agencies.
• Install all electrical connections to local code.
• Use only electrical wire of sufficient gauge and insulation to handle the rated current demand. All

wiring must meet local codes.
• Route electrical wiring along a protected path. Make sure they will not be damaged by moving

equipment.
• Protect components from damage, wear, and harsh environment conditions.
• Allow ample room for maintenance, panel accessibility, and cover removal.
• Protect equipment with safety devices as specified by applicable safety regulations
• If safety devices must be removed for installation, install them immediately after the work is

completed and check them for proper functioning prior to returning power to the circuit.

Failure to follow these instructions can result in serious injury, death or equipment damage

CAUTION
Use this equipment as intended by the manufacturer
This equipment is designed to perform a specific function, do not use this equipment for other
purposes

• Using this equipment in ways other than described in this manual may result in personal injury,
death or property and equipment damage. Use this equipment only as described in this manual.

Failure to follow this instruction can result in serious injury or equipment damage

Constant Current Regulator
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1.1.3 Material Handling Precautions: Storage

1.1.4 Material Handling Precautions, ESD

CAUTION
Improper Storage
Store this equipment properly

• If equipment is to be stored prior to installation, it must be protected from the weather elements
and kept free of condensation and dust.

Failure to follow this instruction can result in equipment damage

CAUTION
Electrostatic Sensitive Devices
This equipment may contain electrostatic devices

• Protect from electrostatic discharge.
• Electronic modules and components should be touched only when this is unavoidable e.g.

soldering, replacement.
• Before touching any component of the cabinet you shall bring your body to the same potential as

the cabinet by touching a conductive earthed part of the cabinet.
• Electronic modules or components must not be brought in contact with highly insulating materials

such as plastic sheets, synthetic fiber clothing. They must be laid down on conductive surfaces.
• The tip of the soldering iron must be grounded.
• Electronic modules and components must be stored and transported in conductive packing.

Failure to follow this instruction can result in equipment damage
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1.1.5 Operation Safety

1.1.6 Maintenance Safety

1.1.7 Touch Current

CAUTION
Improper Operation
Do Not Operate this equipment other than as specified by the manufacturer

• Only qualified personnel, physically capable of operating the equipment and with no impairments in
their judgment or reaction times, should operate this equipment.

• Read all system component manuals before operating this equipment. A thorough understanding of
system components and their operation will help you operate the system safely and efficiently.

• Before starting this equipment, check all safety interlocks, fire-detection systems, and protective
devices such as panels and covers. Make sure all devices are fully functional. Do not operate the
system if these devices are not working properly. Do not deactivate or bypass automatic safety
interlocks or locked-out electrical disconnects or pneumatic valves.

• Protect equipment with safety devices as specified by applicable safety regulations.
• If safety devices must be removed for installation, install them immediately after the work is

completed and check them for proper functioning.
• Route electrical wiring along a protected path. Make sure they will not be damaged by moving

equipment.
• Never operate equipment with a known malfunction.
• Do not attempt to operate or service electrical equipment if standing water is present.
• Use this equipment only in the environments for which it is rated. Do not operate this equipment in

humid, flammable, or explosive environments unless it has been rated for safe operation in these
environments.

• Never touch exposed electrical connections on equipment while the power is ON.

Failure to follow these instructions can result in serious injury, death or equipment damage.

DANGER
ELECTRIC SHOCK HAZARD
THIS EQUIPMENT MAY CONTAIN ELECTROSTATIC DEVICES

• DO NOT OPERATE A SYSTEM THAT CONTAINS MALFUNCTIONING COMPONENTS. IF A COMPONENT
MALFUNCTIONS, TURN THE SYSTEM OFF IMMEDIATELY.

• DISCONNECT AND LOCK OUT ELECTRICAL POWER.
• ALLOW ONLY QUALIFIED PERSONNEL TO MAKE REPAIRS OR REPLACE MALFUNCTIONING

COMPONENTS ACCORDING TO INSTRUCTIONS PROVIDED IN MANUAL.

FAILURE TO FOLLOW THESE INSTRUCTIONS CAN RESULT IN DEATH OR EQUIPMENT DAMAGE

WARNING
Touch current exceeds 3.5mA AC. The minimum size of the PE conductor shall comply with the local safety regulations
for high PE conductor current equipment.

Constant Current Regulator
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2.0 Description
Figure 1: Series cirSeries circuit system ocuit system ovvererviewview

A Input power supply

B Manual switch

C Remote control system

D Equipment

E Output disconnection device (optional)

F Series circuit

The equipment is a microprocessor-controlled Constant Current Regulator with an optional output disconnection device
(circuit selector).

2.1 Intended Use
The equipment is designed to convert an AC sine wave input voltage into an adjusted output current selected in brightness
steps to supply a series AGL circuit.

Any other or additional use will not considered to be in conformity with the purpose.

Do not operate the equipment outside the limits of the specifications or outside the specified ambient conditions.

2.2 Working Principle
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A Line input. See Line input

B Input filter. See Input filter

C Diode bridge and sensing PCB, components of the IGBT power bridge. See IGBT power bridge

D IGBT module and IGBT PCB, components of the IGBT power bridge. See IGBT power bridge

E Output filter. See Output filter

F Main transformer. See Main transformer, all cabinets

G Output measure PCB. See Output measure PCB (EPS422), all cabinets

H Lightning arrestors. See Power output

I Circuit selector (optional). See Circuit selector (CS)

J Series output connection. See Remote control

K CPU PCB. See CPU PCB (EPS479), all cabinets

L HMI. See HMI

M Remote control PCB. See Remote control PCB (EPS495 or EP00047), all cabinets

N Power supply PCB. See Power supply PCB (EPS480), all cabinets

Legend
▪ Red lines: current

▪ Green lines: signal wires connections

▪ Black lines: low voltage connections

Current regulation
The equipment converts the single phase input voltage line into a rectified current and voltage. The equipment then converts
this DC current and voltage into a pure sine wave with a defined power rating.

Main feedback loop
The output measure PCB sends the measured output to the CPU PCB. Depending on the output, the CPU PCB automatically
generates a signal to adjust the regulation.

2.3 Layout of the Equipment Cabinet

Constant Current Regulator
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2.3.1 Outside - stackable cabinet 2.5 kVA

A Ventilation grids

B HMI

C Serial communication port

D Manual switch

E Remote control connector

F Series output connection. The illustration shows the SCB.

G Output to Series Circuit

H Power supply connector
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2.3.2 Inside - stackable cabinet 2.5 kVa

A Lightning arrestors

B Input filter

C Ouput filter

D Manual switch

E Sensing transformer

F Power supply transformer

G IGBTs

H IGBT-PCBs (EPS477)

I Diode bridge + sensing PCB (EPS476)

J CPU PCB (EPS479)

K Power supply PCB (EPS480)

L Remote control PCB (EPS495 or EP00047)

M Line filter

N Main transformer

O Output measure PCB (EPS442)

P Main contactor

Q Main fuses

Constant Current Regulator
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2.3.3 Outside - small cabinet: 2.5 to 15 kVA

A Ventilation grids

B HMI

C Serial communication port

D Manual switch

E Remote control connector

F Series output connection. The illustration shows the SCO

G Output to Series Circuit

H Ethernet connector

I Power supply cable entry

2.3.4 Inside - small cabinet: 2.5 to 15 kVA

Note
The illustrations show the 10 kVA cabinet.
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A Output filter

B CPU PCB

C Main fuses

D Main contactor

E Sensing transformer

F IGBT

G IGBT PCB (EPS477)

H Diode bridge and sensing PCB (EPS476 / EPS507)

I Power supply PCB (EPS480)

J Input filter

K Remote control PCB (EPS495 or EP00047)

L Lightning arrestors

M Output measure PCB (EPS442)

N Input terminals

O Line filter

P Main transformer

Q Power supply transformer

Constant Current Regulator
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2.3.5 Outside - small cabinet: 2.5 to 15 kVA with CS (option CS)

A Ventilation grids

B HMI

C Serial communication port

D Manual switch with lockable cover

2.3.6 Inside - small cabinet: 2.5 to 15 kVA with CS (option CS)

A Interface PCB (PCB1702)

B Power supply convertors for multiwire remote control

C Input terminals

D Lightning arrestors

E CS PCB (PCB1619)

F Current sensors

G CS relays

H Connection terminals for the primary circuit

I Supports

Note
The illustration shows only the items of the CS. For all other items, see Inside - small cabinet: 2.5 to 15 kVA.
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2.3.7 Outside - big cabinet 20 to 30 kVA

A Ventilation grids

B HMI

C Serial communication port

D Manual switch

E Remote control connector

F Series output connection. The illustration shows the SCO

G Output to Series Circuit

H Ethernet connector

I Power supply cable entry

Constant Current Regulator
Description

12
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



2.3.8 Inside - big cabinet 20 to 30 kVa

A Line filter

B Input filter

C Power supply PCB (EPS480)

D Power supply transformer

E CPU PCB (EPS479)

F Sensing PCB (EPS476)

G Diode Bridge

H Main fuses

I Main contactor

J IGBT-PCBs (EPS496)

K IGBTs

L Sensing transformer

M Output filter

N Remote control PCB (EPS495 or EP00047)

O Lightning arrestors

P Output measure PCB (EPS442)

Q Hall sensor

R Input terminals

S Main transformer
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2.3.9 Outside - big cabinet: 20 to 30 kVA with CS (option CS)

A Ventilation grids

B HMI

C Serial communication port

D Manual switch

2.3.10 Inside - big cabinet: 20 to 30 kVA with CS (option CS)

A Interface PCB (PCB1702)

B Power supply convertors for multiwire remote control

C Input terminals

D Lightning arrestors

E CS PCB (PCB1619)

F Current sensors

G CS relays

H Connection terminals for the primary circuit

I Supports

Note
The illustration shows only the items of the CS. For all other items, see Inside - small cabinet: 2.5 to 15 kVA.

Constant Current Regulator
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2.4 Components
For the exact location and connectors see Layout of the Equipment Cabinet and the electrical scheme. You can find the
electrical scheme attached on the outside of the equipment.

2.4.1 Line input
Figure 2: Input terminal, all cabinetsInput terminal, all cabinets

The input terminal connects the power input cables to the equipment.

Figure 3: Line filterLine filter, all cabinets, all cabinets

The line filter blocks the noise the equipment generates to the line input and filters out voltage pulses from the input voltage.

Figure 4: Manual switch, all cabinetsManual switch, all cabinets

The manual switch is a magneto-thermal switch that connects the mains power supply to the equipment. You can manually
set the switch to the ON or OFF position.
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Figure 5: Main fuses, all cabinetsMain fuses, all cabinets

The main fuses disconnect the equipment from the mains power supply if the input current is above a given value.

Figure 6: Main contactMain contactoror, stackable cabinet and small cabinet, stackable cabinet and small cabinet

The main contactor allows the power supply PCB to automatically interrupt the power.

Figure 7: Main contactMain contactoror, big cabinet, big cabinet

The main contactor allows the power supply PCB to automatically interrupt the power.

The resistors on the precharge PCB limit the current for the precharge of the capacitor bank.

Figure 8: Sensing trSensing transformeransformer, all cabinets, all cabinets

Constant Current Regulator
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The sensing transformer measures the input voltage level of the line input.

Figure 9: PPower supply trower supply transformeransformer, all cabinets, all cabinets

The power supply transformer:

▪ Supplies the zero crossing signal determined from the input voltage.

▪ Provides the correct current and voltage to power all the electronic components such as PCBs and to power the fans
(for 15 to 30kVA equipment).

2.4.2 Input filter
Figure 10: Input filterInput filter, stackable cabinet and small cabinet (ex, stackable cabinet and small cabinet (except 15 kVcept 15 kVA)A)

The input filter is a 12.5 kHz filter that blocks the noise the equipment produces from the line input at a different frequency
than the line filter.

Figure 11: Input filterInput filter, 15 kV, 15 kVA small cabinet and big cabinetA small cabinet and big cabinet

The input filter is a 12.5 kHz filter that blocks the noise the equipment produces from the line input at a different frequency
than the line filter.
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2.4.3 IGBT power bridge
The IGBT power bridge has the following components:

▪ Diode bridge + sensing PCB

▪ IGBT PCB

▪ IGBT

Figure 12: Diode bridge + sensing PCB (EPS476 /EPS507), stackable cabinet and small cabinetDiode bridge + sensing PCB (EPS476 /EPS507), stackable cabinet and small cabinet

The diode bridge converts the AC line input to a rectified current and voltage.

The sensing PCB measures the AC input line.

Figure 13: Sensing PCB (EPS476), big cabinetSensing PCB (EPS476), big cabinet

The sensing PCB measures the AC input line and controls the diode bridge.

WARNING
If one of these three components breaks, replace the entire IGBT power bridge.

Note
In the stackable cabinet and the small cabinet, the sensing PCB and the diode bridge are combined into one part.

Note
In the big cabinet, the sensing PCB and the diode bridge are separate parts.

Constant Current Regulator
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Figure 14: Diode bridge, big cabinetDiode bridge, big cabinet

The diode bridge converts the AC line input to a rectified current and voltage.

Figure 15: IGBIGBTT, all cabinets, all cabinets

An IGBT controls a high power via a low power electronic signal.

The IGBT can switch at high frequency.

Two IGBTs are installed together in one housing.

The system uses four IGBTs connected as an H-bridge to make an AC-signal.

Figure 16: IGBIGBT PCB (EPS477 /EPS496 /EPS 478), all cabinetsT PCB (EPS477 /EPS496 /EPS 478), all cabinets

The IGBT PCB measures the output signal from the IGBT H-bridge.

Note
In the big cabinet, the sensing PCB and the diode bridge are separate parts.
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2.4.4 Hall sensor, big cabinet

The Hall sensor measures the current between the IGBT and the output filter.

2.4.5 Output filter
Figure 17: Output filterOutput filter, stackable cabinets and small cabinet (ex, stackable cabinets and small cabinet (except 15 kVcept 15 kVA)A)

The output filter is a Pulse Width Modulation (PWM) filter that builds the pure sine wave signal that comes from the H-bridge.

Figure 18: Output filterOutput filter, 15 kV, 15 kVA small cabinet and big cabinetA small cabinet and big cabinet

The output filter is a Pulse Width Modulation (PWM) filter that builds the pure sine wave signal that comes from the H-bridge.

Constant Current Regulator
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2.4.6 Main transformer, all cabinets

The main transformer converts the pure sine wave to the correct output voltage and current.

2.4.7 Output measure PCB (EPS422), all cabinets

The output measure PCB measures the output voltage and current and sends these measurements to the CPU PCB.

The EFD (See Earth Fault Detection (EFD) ) and LFD (See Lamp Fault Detection (LFD)) logic is also located on the output
measure PCB.

2.4.8 Power output

Lightning arrestors, all cabinets

▪ The lightning arrestors are installed on the power output. The lightning arrestors are varistors.

▪ A varistor is a surge protection device that is connected directly across the AC output.

Connection to the series circuit
▪ There are mutual exclusive options possible. See Options.

UM-6008, Rev. 2.9.0, 2026-02-20 21
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



2.4.9 CPU PCB (EPS479), all cabinets

The CPU PCB:

▪ Receives the measurement data of the output current and voltage from the output measure PCB via an optical fibre and
compares these values with the required values. A software algorithm processes this data to adjust the signals from the
output filters.

▪ Receives and processes input signals from the HMI and the remote control PCB.

2.4.10 Remote control PCB (EPS495 or EP00047), all cabinets

The equipment can be monitored or controlled remotely with J-Bus (2-wire RS485), multiwire or ethernet. This remote control
allows the remote control system to:

▪ Receive information about the equipment.

▪ Configure the brightness steps.

▪ Test the equipment.

Note
Until 2022, the CRE was delivered with the EPS495 board as the remote control PCB. Since 2022, the CRE has been
delivered with the EP00047, and the EP00051 as an add-on board when Multiwire is required. The functionalities of
these boards are equivalent in most cases, with the exception of the most demanding recent ALCMS systems with a
redundant bus. For CRE units equipped with the EPS495, there are options to transition to the EP00047 (and the
EP00051 add-on if needed) when required. Please contact your ADB SAFEGATE representative for more details if
needed.
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The remote control PCB connects the equipment to the remote control system. The internal connection between the remote
control PCB and the CPU PCB goes through an optical fibre.

2.4.11 Power supply PCB (EPS480), all cabinets

The power supply PCB provides the power supply for:

▪ All electronic components such as PCBs of the equipment

▪ The fans (for 15 to 30 kVA equipments)

▪ The control for the main contactor

The power supply PCB also manages the safety switches on the panels.

2.4.12 Lamp Fault Detection (LFD)
The equipment analyses the output current and the voltage pattern to calculate, on a linear load, the number of open
circuited lamps, in compliance with IEC 61822:2009.

The accuracy is ± 1 lamp with a range from 1 to 15 broken lamps.

The HMI shows the actual LFD value.

2.4.13 Earth Fault Detection (EFD)
The EFD measures the insulation resistance between the series circuit and the earth in compliance with IEC 61822:2009.

The EFD module works when the equipment is connected to the mains supply, even if no output current is present.

You can set two alarm levels, Level 1 and Level 2, for the measured values. Both alarm levels can be set to any value between
5 kOhm and 500 MOhm. However, Level 1 must always be higher than Level 2.

Working principle: A high-voltage resistor applies a stable, current-limited voltage of 450 VDC between the series circuit and
the earth or cable screen.

The HMI shows the actual EFD value.

Note
For EPS495, remote control through an ethernet connection requires an additional PCB. See Ethernet PCB (EPS542), all
cabinets.

Note
For EP00047, Multiwire support requires an add-on PCB, EP00051.

Note
EFD measurement is done through a DC voltage with a positive voltage applied on to the series circuit and the 0 (zero)
to the earth.
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2.5 Options

2.5.1 Remote control

The following remote control connections are possible:

▪ Ethernet (Ethernet PCB required for EPS495)

▪ Single

▪ Double

▪ J-Bus

▪ Single

▪ Double

▪ Multiwire with 8 input signals and 17 output signals, always possible to monitor via single J-Bus. For CRE units equipped
with EP00047, the add-on board EP00051 is also required.

2.5.2 Ethernet PCB (EPS542), all cabinets

.

The ethernet PCB converts the ethernet to an RS-485 signal. This PCB is required for EPS495 if you need to remotely operate
the equipment through an ethernet connection.

The illustration shows a double ethernet connection.

2.5.3 Multiwire PCB (EP00051), all cabinets
The EP00051 is a mezzanine board which is designed for multiwire connection support for CRE units since 2022. This board is
required in addition to the EP00047 if you need to remotely operate the equipment through a multiwire connection.

2.5.4 Circuit selector (CS)
With a CS you can connect several (up to eight) series circuits to a single equipment.

The CS has two modes:

▪ Simultaneous: the equipment can connect to a number of the available circuits at the same time

Note
Until 2022, the CRE was delivered with the EPS495 board as the remote control PCB. Since 2022, the CRE has been
delivered with the EP00047, and the EP00051 as an add-on board when Multiwire is required. The functionalities of
these boards are equivalent in most cases, with the exception of the most demanding recent ALCMS systems with a
redundant bus. For CRE units equipped with the EPS495, there are options to transition to the EP00047 (and the
EP00051 add-on if needed) when required. Please contact your ADB SAFEGATE representative for more details if
needed.

Note
This applies to CRE units equipped with EPS495.
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▪ Alternate: the equipment can connect to only one circuit at a time

2.5.5 Lightning arrestors (option CS)

The additional lightning arrestors for the CS are installed on the power output. The lightning arrestors are varistors.

A varistor is a surge protection device that is connected directly across the AC output.

2.5.6 Interface PCB (PCB1702) (option CS)

The interface PCB is the remote control interface PCB of the equipment, if the equipment has a CS.

2.5.7 CS PCB (PCB1619) (option CS)

Note
This item is installed on the CS when the CS option is chosen.

Note
This item is installed on the CS when the CS option is chosen.

Note
This item is installed on the CS when the CS option is chosen.

UM-6008, Rev. 2.9.0, 2026-02-20 25
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



The CS PCBs drive the CS relays through CANbus and measure the current after the relay with a current sensor. (see Current
sensor (option CS)).

2.5.8 HMI SIN PCB (PCB1703) (option CS)

The HMI SIN BCB provides the indication of the state of the different series circuits (selected or not selected).

2.5.9 Remote control SIN PCB (PCB1694) (option CS)

Note
This item is installed on the CS when the CS option is chosen.

Note
This item is installed on the CS when the CS option is chosen.
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The remote control SIN PCB is the interface between the CPU PCB and the interface PCB

2.5.10 CS relay (option CS)

The CS relays switch on or off its designated series circuit.

2.5.11 Current sensor (option CS)

The current sensors sense current running through the series circuits.

Note
This item is installed on the CS when the CS option is chosen.

Note
This item is installed on the CS when the CS option is chosen.
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2.5.12 Series Connector Box (SCB), all cabinets

The SCB connects the equipment to the series circuit with two medium voltage cables of the primary circuit. The SCB does not
allow the short circuit connection.

2.5.13 Series CutOut (SCO), all cabinets

The SCO acts as an output disconnection device between the equipment and the series circuit. The SCO also isolates the
series circuit from the equipment during maintenance or testing operations. The cover is locked with a key to prevent
unauthorized access.

2.5.14 Rolling castors
The equipment can be supplied with two fixed and two pivoting rolling castors to facilitate the movement of the equipment.
The option is not available for stackable equipments or for an equipment with a CS.

2.6 HMI
You can operate the equipment with the HMI.
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2.7 HMI of an equipment with CS (option CS)
You can operate the equipment with the HMI.

2.8 Nameplate
Each equipment has a standard nameplate:
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3.0 Description of the HMI
Figure 19: HMI oHMI ovvererviewview

A. Display

B. Function buttons

C. Keypad

D. On, Off, Enter, Cancel, Remote and Local buttons

3.1 HMI overview for an equipment with a CS (option CS)

A Function buttons

B Function indicator LEDs

The LED's for the function buttons C1 to C8 are On if the circuit is selected. The LEDs are Off when the circuit is not selected.

The LRN function button is not used.

LED LED colour Description

CS ON Green The equipment and the CS are active

EVENT Red An alarm is active

Note
The HMI of an equipment has the standard HMI (see Description of the HMI), with an extra set of buttons and
indicators.
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LED LED colour Description

LOCAL Red The equipment and the CS are in local mode1

REMOTE Green The equipment and the CS are in local mode1

3.2 Display overview: Main screen

Table 1: Display description: Main screen

Name Description

A Menu Push the corresponding function button to go to the Main menu

B Mode indication Shows the state, LOCAL or REMOTE

C State The state can be OFF or ON

D Brightness level OFF, or BRIGHTNESS 0 to 5. Optionally, more levels are possible.

If the display shows BRIGHTNESS 0, this means that the equipment has a pre-defined current as
output, due to a remote control loss

E Field circuit Shows the name of the field circuit that the equipment delivers power to

F True RMS output voltage Shows the true RMS output voltage in kV

G True RMS output current Shows the true RMS output current in A

H Highest brightness step
counter

Shows the time that the equipment operates at the maximum brightness step in h

I Total brightness counter Shows the total time that the equipment is set to ‘on' in h

J EFD indicator Shows the measurement of the resistance to earth. The equipment continuously measures the
value, also when the equipment is in the OFF state, when the equipment has power

K LFD indicator In normal mode (linear load): Shows the number of broken lamps if the LFD is calibrated

In inductive mode (non-linear load): Shows the text ‘inductive'

L Software version Shows the current software version

M Power rating Shows the power rating of the equipment

1You can only select local or remote control on the equipment
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3.3 Description of general functions
The buttons can have different functions. The display description indicates the dedicated functions. This section shows the
general functions, which are available in several menus.

Table 2: General function buttons

Button Description

→ To go to the next submenu

← To go to the previous submenu

ESC To go to the higher level menu

- To decrease the value

+ To increase the value

YES To confirm the selection

NO To decline the selection

SAVE To save an alphanumeric or numeric string

UP, DOWN, LEFT,
RIGHT

To move the cursor in the display

3.4 Main menu

Table 3: Display description: Menu screen

Name Description

A ESC To return to the Main menu. See Main menu

B OPTIONS To go to the Options menu. See Options menu

C ALARMS To go to the Alarms menu. See Alarms menu

D MAINT To got to the Maintenance menu. See Maintenance menu
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3.5 Options menu
Table 4: Buttons

Button Description

RS232/485 To activate or deactivate the RS232 or RS485 port

MODE To select the correct equipment work mode (see Operation mode):

▪ NORMAL (for linear loads)

▪ INDUCTIVE (for non-linear loads (e.g. LED loads))

ID To change the name of the field circuit that the equipment powers. See How to enter an alphanumeric
string how to enter an alphanumeric string with the HMI

SLVNUM To change the address number of the equipment in the RS485 network

LANG To change the language of the display

CONTR To change the display contrast

LFD To calibrate the LFD

HCOUNT To reset the HOURS indicator

3.6 Alarms menu
Table 5: Buttons

Button Description

RESET To reset the alarm: See also Alarms

FORWARD To show the previous alarm in the list: See also Alarm texts and messages on the HMI .

For an overview of alarm texts and messages, see Alarm texts and messages on the HMI

3.7 Maintenance menu
A password is required to access the maintenance menu.
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Table 6: General function buttons

Button Description

TEST Shows the DSP microcontroller operating parameters. These parameters show the state of the software
process that controls the equipment. These parameters are only for an advanced user.

MORE To go to more submenus:

▪ IGBT TEST

A verification test of the IGBT.

▪ INPUT FREQ

Do not change this parameter.

▪ REMOTE CONTROL MODE

Multiwire or J-Bus

▪ JBUS PROTOCOL

MCR2 protocol or MCR3 protocol

▪ CSE/MODE

Activate circuit selector. Yes or No.

▪ JBUS mode

485 or Ethernet mode

▪ MULTIWIRE CONFIGURATION

To configure the output pins of the multiwire connector. You can change the connector function
with the ON and OFF buttons. To save the configuration, push the ENTER button.

▪ V/I CALIBRATION

Do not use this parameter.

▪ ETHERNET CONFIGURATION

Only for an equipment with the Ethernet Remote Control PCB. To configure the 2 IP addresses.

3.8 Mode menu
Table 7: General function buttons

Button Description

RAMP TIME The time that the equipment takes to change from one brightness step to another, in seconds (0 to 125
s).

HALFWAVE WIDTH To enhance the current peak. You can decrease the half wave width and so reshape the sinosoidal
waveform (50 to 100%). The default value is 100% (no enhancement).

MAX PWM WIDTH To smoothen the maximum current the equipment can supply to prevent a too high current to run on
the lamps. You can reduce maximum power threshold on the PWM cycle (1 to 100%). The default value
is 100% (no threshold on the current output).

CURRENT LIMIT Maximum peak current

PID TYPE Do not change this parameter

3.9 How to enter an alphanumeric string
1. The display shows an alphanumerical matrix (B).

2. Push the LEFT and RIGHT buttons to select the character.

3. Push the ENTER button. The HMI adds the character to the string (A).

4. Push the CANCEL button to delete the last character.

5. Push the SAVE button to confirm the string.
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3.10 Alarm texts and messages on the HMI
There are four types of alarms:

▪ Equipment alarms

▪ The equipment automatically switches OFF. Restart the equipment only after you have found the cause of the
alarm.

▪ The red light goes on but the equipment still operates. Find the cause of the alarm.

▪ Field alarms

▪ The equipment automatically switches OFF. Restart the equipment only after you have found the cause of the
alarm.

▪ The red light goes on but the equipment still operates. Find the cause of the alarm.

Alarm text / message Possible cause Equipment
alarm

Field
alarm

Only
red
light
goes on

Equipment
switches off
automatically

450V EFD MISSING The 450 V EFD test voltage is missing x x

560VDC BUS OVERCURRENT The current on the primary power transformer is
too high

x x

ALARM!!! Several alarms have occurred at the same time x x

BAD REGULATION The current did not reach the selected level within
the ramp up time

x x

DSP ERROR OR WRONG
FIRMWARE

The CPU DSP has failed or the DSP firmware is
corrupted

x x

EFD LEVEL 1 FAULT The resistance to earth is less than level 1 (20
MOhm default value)

x x

EFD LEVEL 2 FAULT The resistance to earth is less than level 2 (2
MOhm default value)

x x

GATE H FAULT There is a problem with the H-bridge (IGBT). On
the HMI, a message shows “IGBT KO: xxx x”

x x

IGBT KO: ... Both IGBTs are broken x x

IGBT KO: BTM A The IGBT A is broken x x

IGBT KO: TOP A The IGBT A is broken x x

IGBT KO: BTM B The IGBT B is broken x x

IGBT KO: TOP B The IGBT B is broken x x
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Alarm text / message Possible cause Equipment
alarm

Field
alarm

Only
red
light
goes on

Equipment
switches off
automatically

IGBT KO: TOP BTM A The IGBT A is broken x x

IGBT KO: TOP BTM B The IGBT B is broken x x

INPUT VOLTAGE TOO HIGH The input voltage is too high x x

INPUT VOLTAGE TOO LOW The input voltage is too low. This can lead to an
over current situation

x x

LFD LEVEL 1 FAULT Minimum 3 broken lamps x x

LFD LEVEL level 2 fault Minimum 5 broken lamps x x

MAIN CONTACTOR FAILED
(OFF)

The main contactor is broken x x

MAIN CONTACTOR FAILED
(ON)

The main contactor is broken x x

MAIN DC <95% The rectified 560 V DC voltage is too low. (Only
applies to 3 phase input)

x x

MAIN REMOTE CTRL SWITCH
OFF

The main remote control switch does not go on
when the microprocessor gives an ‘on' command

x x

MAIN REMOTE CTRL SWITCH
ON

The main remote control switch goes on before
the microprocessor gives an ‘off' command

x x

MANY ERRORS HAVE
HAPPENED, DURING CONTROL

Different alarms are generated in the same alarm
time interval after the equipment startup phase

x x

MANY ERRORS HAVE
HAPPENED, DURING ON

Different alarms are generated in the same alarm
time interval during the equipment startup phase

x x

NO FAN One or more fans do not operate correctly x x

ONE PHASE MISSING One phase is missing. The display shows which
phase is missing

x x

OPEN CIRCUIT The output circuit is interrupted. Link the cable
correctly before you restart the equipment

x x

OVERCURRENT ▪ The output current is more than lmax +5%
for minimum 4s

▪ The output current is more than Imax +
20% for minimum 0.4 s

x x

OVERLOAD The load of the equipment is too high x x

OVERVOLTAGE FROM FIELD The “IGBT OVP” has stopped the equipment when
it could not find a suitable operation mode after
several retries

x x

PHASE ERROR There is a problem with the mains frequency
detection

x x

PIC COMMUNICATION ERROR A faulty communication with the measurement
PCB

x x

PRE-CHARGE CONTACTOR ON The pre-charge contactor is broken (VIS only) x x

PRE-CHARGE CONTACTOR OFF The pre-charge contactor is broken (VIS only) x x

SCO / DOOR OPENED A front, rear and or field connection panel is open x x
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Alarm text / message Possible cause Equipment
alarm

Field
alarm

Only
red
light
goes on

Equipment
switches off
automatically

TEMPERATURE SENSOR FAULT There is a fault in the temperature measurement
circuit

x x

TLC ERROR There is an error on the remote control PCB x x

TOO HIGH TEMPERATURE The temperature of the heat sink is too high x x

V IN UNSTABLE The input voltage is not stable x x

VA DROP LEVEL EXCEEDED The output power goes below a preset level x x
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4.0 Description of the configuration software tool
With the configuration software tool, you can:

▪ Read the state of the equipment (alarms, output current, input current)

▪ Read the configuration of the equipment

▪ Adjust the configuration of the equipment

▪ Test the equipment

▪ Send writing and reading commands to the equipment

To update the software version, contact ADB SAFEGATE.

4.1 Description of screens and menus
Figure 20: GenerGeneralal

Description

A Slave To select the slave number of the equipment you want to connect to

B Connection To open and close the port to the selected slave number

C Rem Reset To reset the alarm. See also Alarms

D Restore
configuration

To restore a saved configuration from the PC to the equipment

E Save configuration To make the values sent to the equipment active on eeprom

The values you send to the equipment are not active on the eeprom

F Default
configuration

To return to the factory default configuration

G Message bar Shows communication messages and error messages about the software configuration tool

H Exit To exit the configuration software tool

WARNING
When you activate the configuration tool, you transfer all control of the equipment to the configuration software
tool. In this situation, remote or local control of the equipment is not possible.
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You can adjust the values in the yellow areas (A).

You cannot adjust values in the orange areas (B).

White selection boxes: if the box is marked, the item applies (C).

4.1.1 Screens
▪ CCR Status screen. See CCR status screen

▪ Output/Mains screen. See Output/Mains screen

▪ Test screen. See Test screen

▪ Configuration screen. See Configuration screen

▪ EFD/LFD screen. See EFD/LFD screen

▪ Diag/Dsp/BUS screen. See Diag/Dsp/BUS screen

▪ Copy Parameters screen. See Copy Parameters screen

▪ Log screen. See Log screen

▪ Test JBus screen. See Test JBus screen

4.2 CCR status screen

Description

A Active step Shows the active brightness step of the selected equipment

B Burnt lamps Shows the number of burnt lamps in the series circuit

C CCR Status See CCR Status

D EFD Errors See EFD Errors

E Bus Error Only applies to a double J-Bus or Ethernet connection
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Description

F LFD Errors See LFD Errors

G Regulation Errors See Regulation Errors

H CCR Errors See CCR Errors

I Mains Voltage
Errors

See Mains Voltage Errors

J Output See Output

K Start To show the parameters of the selected slave equipment

L Stop To stop to show the parameters of the slave equipment

4.2.1 CCR Status
Item Description

Event An error event occurred

DB Chgd A change was made to the database

DB Valid The data in the database is up to date

CCR Master ▪ LOCAL SELECTOR: the master is in LOCAL mode

▪ PC: the RS232 port of the master is active

▪ BUS A. The J-BUS is active and the master is in REMOTE mode

4.2.2 EFD Errors
Possible cause Alarm type

Level 1 exceeded The resistance to earth is less than level 1 (20
MOhm default value)

The red light on the equipment goes on

Level 2 exceeded The resistance to earth is less than level 2 (2 MOhm
default value)

450V supply out of range The 450 V EFD test voltage is missing

Scale Shows 0 for a 20 pA EFD scale and 1 for a 200 pA EFD scale

Isolation resistance Shows the isolation resistance value (0 to 500 MOhm)

4.2.3 LFD Errors
Possible cause Alarm type

Level 1 of Burnt Lamps is exceeded Minimum 3 broken lamps The red light on the equipment goes on

Level 2 of Burnt Lamps is exceeded Minimum 5 broken lamps

Level 1 VA-Drop is exceeded The output power goes below a preset level

Level 2 VA-Drop is exceeded The output power goes below a preset level

Error in LFD Reference Calibration The LFD reference calibration is not done or is
not successful

Error in LFD Removed Lamps Calibration The LFD removed lamps calibration is not
done or is not successful
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4.2.4 Regulation Errors
Possible cause Alarm type

CCR switched OFF for OVERCURRENT ▪ The output current is more than Imax
+5% for minimum 4s

▪ The output current is more than Imax +
20% for minimum 0.4s

▪ The equipment automatically
switches OFF

▪ Restart the equipment only after
you have found the cause of the
alarm

CCR switched OFF for OPEN CIRCUIT The output circuit is interrupted. Connect the
cable correctly before you restart the
equipment

Measure board connector disconnected There is no communication between the CPU
PCB and the measure PCB

Possible root causes:

▪ The optical cable is disconnected

▪ The power supply cable is disconnected

▪ Malfunction of the measure PCB

CCR is in OVERLOAD The load of the equipment is too high

Output current is unstable The output current fluctuates or could not
reach the requested value

Possible root causes:

▪ Load switching (E.g. Aglas, Brite)

▪ To much load on the series circuit

4.2.5 CCR Errors
Possible cause Alarm type

DC BUS Voltage too low Only for a three-phase equipment. The voltage on
the DC bus does not reach the nominal value

Possible root causes:

▪ Malfunction of the IGBT

▪ The wiring is not connected properly

▪ The equipment automatically
switches OFF

▪ Restart the equipment only after you
have found the cause of the alarm

Temperature Fault The temperature of the heat sink is too high

SCO/Door opened A front, rear and/or field connection panel is open The red light on the equipment goes on

Main Contactor Fault The main contactor does not switch on when the
microprocessor gives an ‘on' command

Possible root causes:

▪ Malfunction of the main contactor

▪ Malfunction of the feedback of the contactor

▪ A faulty connection on the power supply PCB

Pre-Charge Contactor Fault The precharge contactor does not go on when the
microprocessor gives an ‘on' command

Possible root causes:

▪ Malfunction of the main contactor

▪ Malfunction of the feedback of the contactor

▪ A faulty connection on the power supply PCB

Constant Current Regulator
Description of the configuration software tool

42
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



Possible cause Alarm type

Temperature Sensor Fault There is fault in the temperature measurement
circuit

▪ The equipment automatically
switches OFF

▪ Restart the equipment only after you
have found the cause of the alarm

Blower Fault One or more fans do not operate correctly

I Primary Fault There is a problem with the current after the IGBT

IGBT Fault The IGBT test did not succeed after the ‘ON step
request'

Possible root causes:

▪ Malfunction of the IGBT.

▪ A faulty wiring between the CPU PCB and the
IGBT PCB

▪ Malfunction of the IGBT PCB

4.2.6 Mains Voltage Errors
Possible cause Alarm type

Mains Voltage too Low The input voltage is too low. This can lead to an
over current situation

▪ The equipment automatically
switches OFF

▪ Restart the equipment only after you
have found the cause of the alarm

Mains Voltage too high The input voltage is too high

Mains Voltage unstable The input voltage is not stable The red light on the equipment goes on

4.2.7 Output
Item Description

I_out Shows the output current

V_out Shows the output voltage

P_out Shows the output power

V_in Shows the input voltage

Pwm Shows the PWM

4.3 Output/Mains screen
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Description

A Output screen part See items B to F

B Output currents See Off if overload

C Imax Shows the maximum output current

D Overcurrent See Overcurrent

E Off if overload See Off if overload

F Step parameters See Step Parameters

G Read To read the actual Output parameters from the selected equipment

H Mains See Mains

I SHVS Not used

4.3.1 Output currents
Item Description

Number of Steps To select the number of brightness steps

Brightness 1 to 8 To adjust the current for each brightness step, accurate up to 25 mA

Change To activate the values and to send them to the equipment

Example: When you select 4 brightness steps and you select 4.750 A for brightness step 4, brightness steps 5 to 8 are
disabled and get 4.750 A current assigned automatically.

4.3.2 Off if overload
Item Description

CCR Remains ON To make sure that the equipment remains ON when the equipment is in overload state and the alarm
comes up

CCR Switches OFF To make sure that the equipment switches OFF when the equipment is in overload state and the
alarm comes on

Change To activate the values and to send them to the equipment

4.3.3 Overcurrent
Item Description

Level 1 and Level 2 To set the percentage of the maximum of the two thresholds for overcurrent. The screen part also
shows the actual current threshold values

Delay 1 and 2 To set the delay before the overcurrent alarm comes on, in s

Change To activate the values and to send them to the equipment

Note
When you select less than 8 brightness steps, the steps higher than the highest step automatically get the current of the
highest brightness step.
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4.3.4 Step Parameters
Item Description

Step_Speed To set the time that the equipment takes to change from one brightness step to another, in seconds (0 to
125 s)

Inter_Br To define an intermediate brightness between steps

Change To activate the values and to send them to the equipment

4.3.5 Mains
Item Description

V_in_Scale Shows the scale used to calculate the nominal voltage

V_in_Nom Shows the nominal supply voltage

V_in_High To adjust the supply voltage threshold above which the equipment restarts when switched OFF due to too
low supply voltage

V_in_Low To adjust the supply voltage threshold below which the equipment sounds an alarm and switches OFF

V_in_Warn To adjust the voltage threshold above which the equipment sounds an alarm

Frequency_In Shows the supply voltage frequency

Change To activate the values and to send them to the equipment

Read To read the actual Mains parameters from the selected equipment

4.4 Test screen

Description

A Read To read the actual Analogue Data parameters (AD0 to AD7) from the selected equipment

B Brightness See Brightness

C Ctrl Hardware Iprim See Ctrl Hardware Iprim

D Switch on JBUS To enable the J-Bus serial port an to disable the RS232 serial port

E Test Overcurrent To start the overcurrent alarm test

F Test JBUS See Test JBUS
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4.4.1 Brightness
Item Description

Brightness To select the step

Standby To set the selected equipment to stand-by

Change To activate the values and to send them to the equipment

4.4.2 Ctrl Hardware Iprim
Item Description

I primary hardware
protection

Shows if the primary current hardware protection is released. This is a read-only parameter

Reset To reset the primary current hardware protection

Read To read the actual primary current protection parameter from the selected equipment

4.4.3 Test JBUS
Item Description

N. To select the data line

Value To select the test data value

Read To read the actual JBUS parameters from the selected data line

Write To send the selected test data to the selected data line

4.5 Configuration screen

Description

A CCR ID See CCR ID

B Change Slave
Number

See Change Slave Number

C Firmware version Shows the firmware version of the selected equipment

D Firmware details Shows a description on the firmware version of the selected equipment
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Description

E SN/YearCode See SN/YearCode

F Setup Save Date Shows the date and time of the latest save of the data of the selected equipment. The date and time are
generated from the PC that is connected to the equipment

G Maintenance
Password

See Maintenance Password

H Read To read the actual configuration parameters from the selected data line

I Open Circuit Do not use these parameters. There is a risk of damage to the equipment. Only ADB SAFEGATE service
engineers are allowed to use these parameters

J Regulation Rate

K Regulation
Parameters

4.5.1 CCR ID
Item Description

Blank field To change the name of the field circuit that the equipment delivers power to. This name shows in the HMI

Change To activate the value and to send it to the equipment

4.5.2 Change Slave Number
Item Description

Slave Number To adjust the slave number of the selected equipment

Change To activate the value and to send it to the equipment

4.5.3 SN/YearCode
Item Description

YearCode/SN To change the production year and the serial number

Change To activate the value and to send it to the equipment

4.5.4 Maintenance Password
Item Description

Old Password Shows the current maintenance password

New Password To adjust the maintenance password

Confirm Password Copy the adjusted maintenance password for confirmation

Change To activate the value and to send it to the equipment
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4.6 EFD/LFD screen

Description

A EFD Enable See EFD Enable

B EFD Levels See EFD Levels

C Reset error To reset the EFD error

D Read To read the actual EFD parameters from the selected equipment

E LFD Calibrated Shows if the LFD is calibrated

F LFD not Calibrated Shows if the LFD is not calibrated

G LFD Inh See LFD Inh

H LFD Levels See LFD Levels

I VA Drop + delay See VA Drop + delay

J Read To read the actual LFD and VA Drop parameters from the selected equipment

4.6.1 EFD Enable
Item Description

State To select if the EFD measurement is enabled or disabled

Measure If the EFD measurement is enabled, you can choose between these values:

▪ Interval: the interval between measurements is indicated in the Min-Sec field

▪ Continuous: the equipment measure continuously. The Min-Sec field is not active

Min-Sec To set the time between measurement if the measurement is set as interval

Change To activate the value and to send it to the equipment

4.6.2 EFD Levels
Item Description

EFD Range Shows the maximum earth leakage value the equipment can measure

EFD Level 1 To adjust the insulation resistance below which the equipment gives the EFD Level 1 alarm
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Item Description

EFD Level 2 To adjust the insulation resistance below which the equipment gives the EFD Level 2 alarm

Change To activate the value and to send it to the equipment

4.6.3 LFD Inh
Item Description

State To select if the LFD is enabled or not

Mode To choose between different LFD modes:

▪ Normal: both the LFD 1 and 2 Levels are active

▪ Degraded: only LFD 2 Level is active

Change To activate the value and to send it to the equipment

4.6.4 LFD Levels
Item Description

LFD Level 1 and Level 2 To adjust the threshold above which the equipment gives the LFD Level 1 and Level 2 alarm

Change To activate the value and to send it to the equipment

4.6.5 VA Drop + delay
Item Description

VA Drop1 and Drop2 To adjust the threshold above which the equipment gives the VA Drop 1 and Drop 2 alarm

LFD Delay To adjust the minimum time span after the error before the equipment gives the LFD Level 1 or Level
2 alarm

VA Drop Delay To adjust the minimum time span after the error before the equipment gives the VA Drop 1 or Drop 2
alarm

Change To activate the value and to send it to the equipment

4.7 Diag/Dsp/BUS screen
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Description

A Slave errors See Slave Errors

B Rem Reset See Rem Reset

C Dsp parameters See Dsp Parameters

D Imp Test See Imp Test

E Hours_Meter See Hours_Meter

F Bus Parameters ▪ Arbiter: To set the signal source for remote control. To set a priority for different systems. If you set
this parameter to disabled, remote control is not possible.

▪ BF Mode: Use normal or stop bar.

▪ BF Time: The time after which the equipment starts to use the default settings.

▪ BF Def: To set default values that the equipment uses when the remote control (J-Bus) connection is
down for longer than the time set in the menu. Leave this field blank or set a value from 1 to 8.

▪ Select either Stay on Prevent step or Go to Bf-Def.

G Speed See Speed

H Read To read the actual J-Bus parameter of the equipments

4.7.1 Slave Errors
Item Description

Read buttons To read the actual slave error from the selected equipment

Tot_Mess Shows the number of messages that the equipment received

Crc_Err Shows the number of messages with checksum that the equipment received

Exception Shows the number of messages with wrong commands that the equipment received

Own_Mess Shows the number of messages that belong to the selected equipment

No_Ack Shows the number of messages for which the equipment did not receive a reply

Overrun Shows the number of messages with overrun that the equipment received

Silent Shows the if the equipment replies to messages:

▪ 0: the equipment replies to messages

▪ 1: the equipment does not reply to messages

Test field To test the communication. You can enter a number in the field to test

Test button To test the communication with the value in the test field

Restart Communic.Opt To set all counters to 0 and the silent value to 0

Force Listen Only Mode To set the silent field to 1 and to force the equipment to reply to messages

Clear Counters To set all counters to 0 but not to change the silent value

Note
To show the screen part with the bus parameters, select Options>Advanced.
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4.7.2 Rem Reset
Item Description

Rem Reset To enable or disable the Rem Reset button

▪ 1: the Rem Reset button is enabled

▪ 0: the Rem Reset button is disabled

Change To activate the value and to send it to the equipment

Read To read the actual Rem Reset parameter from the selected equipment

4.7.3 Dsp Parameters
Item Description

Dsp_Sel To select what the HMI shows optionally. You can choose from four parameters

The HMI only shows the selected parameter

▪ LAMP: the number of broken lamps

▪ VA_Out: the VA output

▪ VA_Out%: the percentage of the VA output

▪ LMP_Test: to carry out a display test

Desp_Sel_Def To select what the HMI shows optionally. You can choose from four parameters. The HMI shows the selected
parameter, but only for the time indicated in the DSP_Hold field.

▪ LAMP: the number of broken lamps

▪ VA_Out: the VA output

▪ VA_Out%: the percentage of the VA output

▪ LMP_Test: to carry out a display test

Dsp_Hold To adjust the time the HMI shows the optional parameter

Dec_Separ To adjust the decimal separator for the UI (, or .)

Change To activate the value and to send it to the equipment

4.7.4 Imp Test
Item Description

LEDs To carry out a test on the LEDs of the keyboard on the HMI. The LED adjacent to the DB9 connector comes on

Change To activate the value and to send it to the equipment

4.7.5 Hours_Meter
Item Description

Total Shows the total time that the equipment is set to ‘on' in h

Max Br. Shows the time that the equipment operates at the maximum brightness step in h

Read To read the actual hours parameters from the selected equipment
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4.7.6 Rem Reset
Item Description

Rem Reset To enable or disable the Rem Reset button

▪ 1: the Rem Reset button is enabled

▪ 0: the Rem Reset button is disabled

Change To activate the value and to send it to the equipment

Read To read the actual Rem Reset parameter from the selected equipment

4.7.7 Speed
Item Description

BaudRate To adjust BaudRate of the J-Bus connection between the equipments

Parity To adjust the parity of the J-Bus connection between the equipments

Change To activate the value and to send it to the equipment. Do not change the speed parameters when you
connect the equipment with the ethernet line

4.8 Copy Parameters screen

Description

A Load parameters
from ccr

See Load parameters from CCR

B Save To save the parameters from the PC to the selected equipment

4.8.1 Load parameters from CCR
Item Description

Hours meter To select if you want to load/save the hours meter values of the equipment

Lfd calibration To select if you want to load/save the LFD calibration parameters of the equipment

All parameters To select if you want to load/save the all parameters of the equipment

Load To load the selected parameters to the PCCCR
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4.9 Log screen

Description

A Download To show the history file of the selected equipment in the Log screen

B Save Log To save the log file to the PC

4.10 Test JBus screen

Description

A Start Test To start the test

B Stop To stop the test

C No. of slaves Shows the number of slaves

D Reg. start

E No. of reg
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5.0 Circuit selector web interface (option CS)
Figure 21: Description of settingsDescription of settings

A Configuration settings

B Series circuits data

Table 8: Configuration settings

Setting Description

Mode Simultaneous: free circuit selection

Alternate: only 1 circuit selection is possible (only for 2 way CS)

Key local/remote enabled Set to: DISABLE

Circuits number The number of used series circuits

Current threshold Set to: 1500

C1-C8 inputs inverted Set to: NORMAL

C1-C8 outputs inverted Set to: NORMAL

LRN Set to: LRN - disabled - REST = long press

Table 9: Series circuits data

Item Description

Presence YES for detected relays NO for undetected relays

3.3V OK for all connected CS PCBs

KO for all not connected CS PCBs

24V Input voltage measured by the CS PCB

Status relay To check the correction functioning of the relay, push the buttons RELAY ON and RELAY OFF

Current The output current that the CS PCB measures

frm.rel Firmware version on the interface PCB
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6.0 Install and operate the configuration software tool

6.1 Install the configuration tool software

System requirements
▪ PC with Microsoft Windows 2000, XP operation system, or later

▪ At least 50 Mbytes free disk space

▪ 1 free serial communication (COM) port, or a virtual serial communication port over a USB bridge or a PCMCIA card

▪ PC user account with either administrator or power user rights

Move the WINCCR.exe file from the CD-ROM to the hard drive of the PC.

6.2 Start the configuration software tool

Activate the serial port, if applicable

1. On the HMI, push the MENU button to go to the Main menu.

2. Push the SER/JBUS button to go to the SER/JBUS screen.

3. Push the SERIAL button to activate the serial port.

Configure the ethernet port, if applicable
1. On the HMI, push the MENU button to go to the Main menu.

2. Push the MORE button to go to the Mode screen.

3. Push the ETHERNET CONFIGURATION button to configure the ethernet port.

Find the slave number of the equipment
1. On the HMI, push the ESC button to go to the Main menu.

2. Push the OPTIONS button to go to the Options menu.

3. Push the SLVNUM button to show the slave number.

4. Note the slave number. You will need it for reference later.

Connect the serial cable, if applicable
1. Switch OFF the equipment. See Switch OFF the equipment.

2. Connect the extension cable to the dongle (A) and to the serial communication port of the PC (B).
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Connect ethernet cable, if applicable
1. Switch OFF the equipment. See Switch OFF the equipment.

2. Connect the ethernet cable (B) to the equipment (A) and to the PC (C).

Configure the remote control ethernet connection
1. Make sure that the IP range of the PC is in the same range as the device.

2. Access the web control interface of the device.

3. From the Network Settings control panel, set the IP address, Netmask, and IP configuration to the values of the
network that the Ethernet board uses.

4. From the Serial Settings control panel, make sure that the serial parameters have the values that follow:

▪ Baud Rate: 9600

▪ Data Bits: 8

▪ Stop Bits: 1

▪ Parity: None

5. From the Operating Settings control panel, make sure that the Port=01 parameters have the values that follow:

▪ Operation mode: TCP Server Mode

▪ TCP alive check time: 0

▪ Inactivity time: 5000

▪ Max connection: 1

6. Make sure the Data Packing parameters have the values that follow:

▪ Delimiter 1: 0: Do not select Enable

▪ Delimiter 2: 0: Do not select Enable

▪ Force transmit: 10

7. Make sure the TCP Server Mode parameters have the values that follow:

▪ Local TCP port: 502

▪ Do not select Apply the above settings to all serial ports

8. From the Serial Command Mode control panel, make sure the serial parameters have the values that follow:

▪ Trigger Setting: HW Trigger

▪ SW Trigger Character: 2B 2B 2B

Start software
1. Switch the equipment ON.

2. Click the WINCCR.exe file in the directory where you installed the software. The configuration tool opens on the CCR
Status screen.

Constant Current Regulator
Install and operate the configuration software tool

58
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



Set up the serial port, if applicable
1. Select the menu Communication.

2. Select the applicable serial communication port (COM).

3. Push the OK button to confirm the settings.

4. Push the Open Port button to open the selected serial port.

▪ If the settings are correct, the yellow OK button is enabled and the bottom bar shows the message 'Port opened'.

▪ If the settings are not correct, the bottom bar shows an error message.

Set up the Ethernet port if applicable
1. Select the menu Communication>Ethernet.

2. Select the applicable IP address and Port.

3. Push the OK button to confirm the settings.

4. Push the Open Port button to open the selected serial port.

▪ If the settings are correct, the yellow OK button is enabled and the bottom bar shows the message 'Port opened'.

▪ If the settings are not correct, the bottom bar shows an error message.

6.3 Monitor the data of an equipment

Select the equipment
1. Select the slave number of the equipment you want to monitor.

2. Push the OK button.

Start monitoring
1. Select the CCR status screen. See CCR status screen.

2. Push the Start button. The screen shows the data of the selected equipment.

Stop monitoring
▪ Push the Stop button. The screen no longer shows the data of the selected equipment.

6.4 Stop the configuration software tool
1. Serial connection: Disconnect the extension cable from the dongle and the PC connector of the equipment.

2. Ethernet connection: Disconnect the ethernet cable from the PC and the equipment.

Note
The baud rate and parity settings for the communication between the PC and the equipment must be the same.
For the dongle, the default baud rate is 9600 and the default parity setting is None.
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7.0 Commissioning

Main commissioning procedure
1. Do the first start-up. See First start-up.

2. Calibrate the Lamp Fault Detection (LFD) module. See Calibrate Lamp Fault Detection (LFD).

3. Adjust the number of available brightness steps. See Adjust number of used brightness steps.

4. Configure the remote control interface (option). See Remote control configuration: multiwire (option), Remote control
configuration: J-Bus (option), or Remote control configuration: ethernet (option), depending on the hardware.

7.1 First start-up
The equipment stores the last request after a power cycle. This means that when the equipment is switched ON, it starts to
produce the same output current that was valid before the equipment was switched OFF.

When you start up the equipment for the first time, the powering-down status is unknown. This procedure allows you to
prevent the equipment from producing the output current at first start-up.

7.1.1 Procedure
1. Measure the input voltage. See Measure input voltageor Measure input voltage on stackable cabinet.

2. Measure the output current in short circuit. See Measure output current in short-circuit.

3. Measure the resistance and the insulation resistance of the series circuit. See Measure insulation resistance of series
circuit.

4. Measure the output current to the series circuit. See Measure the output current to the series circuit.

7.1.2 Measure input voltage

Prepare
1. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply.

2. Remove the lower rear panel. See Remove panels.

3. Set the manual switch to the ON position.

4. On the HMI, push the Local button. The screen now shows the state LOCAL.

5. Push the OFF button. The equipment goes to the mode OFF.
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Measure
1. Measure the input voltage on the input terminals (A). Use a True RMS Multimeter.

2. Examine if the voltage is in accordance with:

▪ The nameplate of the equipment.

▪ Local regulations.

Finish
1. Switch off the power supply. See Switch OFF the power supply.

2. Install the lower rear panel.

7.1.3 Measure input voltage on stackable cabinet

Prepare
1. Set the manual switch to the ON position.

2. On the HMI, push the Local button. The screen now shows the state LOCAL.

3. Push the OFF button. The equipment goes to the mode OFF.

Measure
1. Measure the input voltage on the pins 1 and 3 (A). Use a True RMS Multimeter.

CAUTION
Excessive input voltage can damage the equipment.
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2. Examine if the voltage is in accordance with:

▪ The nameplate of the equipment.

▪ Local regulations.

Finish
1. Switch off the power supply. See Switch OFF the power supply.

2. Install the lower rear panel.

7.1.4 Measure output current in short-circuit
1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Put the output in short-circuit. For SCB, see Put SCB in short-circuit. For SCO, see Put SCO in short circuit.

3. Measure the output current in short-circuit. See Measure the output current in short circuit.

4. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

5. If you use an SCB: Remove the separate piece of cable and connect the series circuit cables. See Put SCB in short-circuit.

6. If you use an SCO: set the SCO to mode A. See Operation mode.

7.1.5 Put SCB in short-circuit

Strip cables

Strip a separate piece of series circuit cable at both ends.

▪ A: unscreened cables

▪ X: 16 mm

▪ Ø Y: less than or equal to 18 mm

▪ B: unscreened cables

▪ X: 16 mm

▪ Ø Y: less than or equal to 18 mm

▪ U: 11 mm

▪ Z: 77 mm

CAUTION
An excessive input voltage can damage the equipment.
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Remove the box panel of the SCB
1. Loosen the screws (A).

2. Remove the box panel (B).

Short circuit SCB with separate piece of output cable
1. Disconnect the series circuit cables.

2. With the separate piece of output cable (B), short-circuit the output terminals (A).

3. Install the box panel.

7.1.6 Put SCO in short circuit
Set the SCO to mode C. See Operation mode

7.1.7 Measure the output current in short circuit

Connect AC True RMS multimeter (SCB)
▪ Connect the current clamp of an AC True RMS multimeter (B) to the short-circuited cable (A).
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Measure output current
1. Switch ON the equipment and set it to LOCAL mode. See Operation.

2. Select the step 6.6 A.

3. Read the output current value from the AC True RMS Multimeter.

4. Repeat the previous steps and examine the output current value for each brightness step. Check each brightness step
separately from the highest to the lowest level.

7.1.8 Test CS in short-circuit (option CS)
Test the CS to make sure that the equipment produces the correct output current.

Prepare
1. Make sure that all power to the equipment is OFF. See Switch OFF the equipment.

2. Remove the front panel and the CS cabinet panel. See Remove panels.

3. Remove the output cable.

Strip cable
1. Strip a separate piece of output cable:

a. unscreened cables

▪ X: 16 mm

▪ Ø Y: less than or equal to 7 mm

▪ Ø Z: less than or equal to 12 mm

b. screened cables

▪ X: 14 mm

▪ Ø Y: less than or equal to 14 mm

▪ Z: less than or equal to 50 mm

Short-circuit
With the separate piece of output cable, short-circuit the series circuit terminals (A).

Note
The illustration shows an equipment with connections to two series circuits, both in short-circuit. The procedure for
more or less series circuits is similar.
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Connect AC True RMS multimeter

Connect an AC current clamp (A) and a True RMS multimeter (B) to the first short-circuited cable (C).

Activate Circuit 1

1. Switch ON the equipment. See Operation.

2. Push the C1 button (A) to select Circuit 1. The indicator for circuit 1 (B) goes on.
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Measure

1. Adjust the brightness step until the HMI shows 6.6 A for True RMS output current (A). See Select brightness step.

2. If the output current on the AC True RMS multimeter does not reach 6.6 A, change the series circuit configuration
before you proceed.

3. Repeat the previous steps and examine the output current value for each step. Go through all steps separately from the
highest to the lowest level.

Repeat

1. Make sure that all power to the equipment is OFF. See Switch OFF the equipment.

2. Install the AC True RMS multimeter on the next circuit.

3. Activate the next circuit.

4. Measure the output current for the next circuit.

5. Repeat the previous steps for all circuits.

Repeat

1. Make sure that all power to the equipment is OFF. See Switch OFF the equipment.

2. Install the front panel and the CS cabinet panel.

7.1.9 Measure output current series circuit (option CS)
The procedure applies to simultaneous circuit selectors. For alternate circuit selectors, measure each circuit separately.

Prepare
1. Switch ON the equipment. See Operation.

2. Push the C1 button (A) to select Circuit 1. The indicator for circuit 1 (B) goes on.

3. Repeat the previous step again and select all circuits.
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Measure

1. Adjust the brightness step until the HMI shows 6.6 A for True RMS output current (A). See Select brightness step.

2. If the output current does not reach 6.6 A, change the series circuit configuration before you proceed.

3. Examine if all lights to the respective circuits have a similar current level. Go to the runway area to make a visual
inspection.

Finish

1. Disable each circuit one by one menu (the indicators must be OFF). After you disable a circuit, check that the lights in
that circuit go OFF.

2. Set the equipment to OFF. See Switch OFF the equipment.

7.1.10 Measure resistance and the insulation resistance of series circuit
1. Prepare the series circuit. For SCB, see Prepare with SCB. For SCO, see Prepare with SCO.

2. Measure the resistance of the series circuit. See Measure resistance of series circuit.

3. Measure the insulation resistance of the series circuit. See Measure insulation resistance of series circuit.

4. Calculate minimum insulation resistance of series circuit. See Calculate minimum insulation resistance of series circuit.

5. Calculate resistance of series circuit See Calculate resistance of series circuit.

6. Complete the activities. See Complete the measurement.

7.1.11 Prepare with SCB

Set power to OFF
▪ Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

Remove the box panel

1. Loosen the screws (A).

2. Remove the box panel (B).

Discharge the output terminals

1. Discharge the output terminals.

2. Completely remove the series circuit cables, also the shielding, if applicable.
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7.1.12 Prepare with SCO

Set power to OFF

1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Set the SCO to mode C. See Operation mode. The output terminals are now discharged.

Remove cover

1. Open the lock (A).

2. Remove the cover (B). Use the handle.

Remove series circuit cables
▪ Completely remove the series circuit cables, also the shielding, if applicable.

7.1.13 Measure resistance of series circuit
Measure the resistance: measure on the ends of the series cable (A). Use a multimeter (B), in accordance with local
regulations.
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7.1.14 Measure insulation resistance of series circuit
1. Join the ends of the series circuit cables (C).

2. Measure the insulation resistance of the series circuit. Use the insulation tester (E). Megger 5000 V or 10000 V, in
accordance with local regulations.

▪ A: when the series circuit cable is not shielded

▪ B: when the series circuit cable is shielded. Measure the earth on the shield (D).

7.1.15 Calculate minimum insulation resistance of series circuit

Table 10: Theoretical insulation resistance for the series circuit

Item Maximum insulation resistance current (standard: ICAO, part 5, §
3.9.4.7) [μA]

Series transformer 2

100 m of cable with standard number of connectors 1

Example: a runway center-line circuit with 133 light fixtures with a total length of the series circuit of 8 km.

▪ Allowed insulation resistance current for the transformers is 133 x 2 = 266 μA

▪ Allowed insulation resistance current the cable is 80 x 1 = 80 μA

▪ Total allowed insulation resistance current for this circuit is 266 μA + 80 μA = 346 μA

▪ When you test with 5000 V, according to Ohms law, the minimum resistance is 14 MOhm.

7.1.16 Calculate resistance of series circuit
Rprim = ρ x L/A + y x 0.1212

Where:

▪ Rprim = resistance of the series circuit in Ohm

▪ ρ = 18 x 10-3 (Ohm x mm2)/m

▪ L = length of the circuit in m

▪ A = section of the cable in mm2

▪ y = number of series transformers in the circuit

Example:

circuit length is 8000 m

cable section is 6 mm2

number of series transformers is 122

Then Rprim = (18 x 10-3) x 8000/6 + 122 x 0.1212 = 36.7 Ohm

7.1.17 Complete the measurement
1. Make sure that the measured and the calculated values match and that all the values are in accordance with all local

safety regulations.
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2. Connect the series circuit cables to the equipment.

3. Install the cover or the box panel.

7.1.18 Measure the output current to the series circuit

Prepare

1. Make sure that the series circuit is measured and approved. See Measure resistance and the insulation resistance of
series circuit.

2. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

3. Make sure that the series circuit is connected.

4. Connect an AC current clamp (B) to the series circuit cable (A).

Measure
1. Switch ON the equipment and set it to LOCAL mode. See Operation.

2. Select the step 6.6 A.

3. If the output current does not reach 6.6 A, change the series circuit configuration before you proceed. This indicates
that the equipment is too small for the load.

4. Compare the output current reading on the HMI with the reading on the True RMS Multimeter.

5. Examine if the output current readings are in accordance with local regulations. If not, do not continue.

Check brilliancy level
1. Examine if all light fittings have the same brilliancy level. Go to the runway area to make a visual inspection.

2. Examine all the brightness steps separately. Go through the whole procedure for each brightness step.

Finish
1. Wait for approximately 30 minutes and make sure that he equipment works correctly.

2. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

7.2 Calibrate Lamp Fault Detection (LFD)
Follow this procedure to make sure that the equipment indicates the correct number of broken lamps. See Input filter for the
accuracy of the LFD.

CAUTION
The LFD module does not work if the series circuit includes these types of lights:

▪ LED lights without the monitoring option

▪ PVO/PVL lights (guidance signs)

▪ WIGWAG (runway guard lights)
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Make sure that all lamps in the series circuit operate
1. Make sure that the equipment is connected to the series circuit.

2. Switch ON the equipment and set it to LOCAL mode. See Preliminary checks.

3. Set the equipment to the highest brightness step. See Checks and measurements.

4. Examine if all light fittings light up. Go to the runway area to make a visual inspection.

5. Push the OFF button on the UI.

Select LFD calibration
1. On the HMI, push the Options button to go to the Calibrate Lamp Fault Detection menu.

2. Push the LFD button. The HMI prompts you to do the calibration.

3. Push the Yes button. The HMI prompts you regarding the number of burnt lamps (0 - 99).

4. Select '0', no broken lamps.

5. Wait until the equipment shows the Main screen. See Display overview: Main screen

Remove lamps
1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Earth the series circuit

▪ With the SCO. See Use Series CutOut (SCO)

▪ With an earthing wire on the SCB

3. Remove the desired number of lamps in the field.

4. Switch ON the equipment and set it to LOCAL mode. See Operation.

Set number of removed lamps
1. On the HMI, push the Options button to go to the Options menu.

2. Push the LFD button. The HMI prompts you to do the calibration.

3. Push the Yes button. The HMI prompts you regarding the number of burn lamps (0 - 99).

4. Enter the number of removed lamps.

5. Wait until the equipment shows the Main screen. See Display overview: Main screen.

Examine the LFD measurement
1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Connect a number of lamps, but not all.

3. Switch ON the equipment and set it to LOCAL mode. See Operation.

4. Make sure that the number of lamps removed corresponds to the LFD reading on the main menu.

5. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

6. Leave the equipment OFF for 10 seconds.

7. Repeat the previous steps and connect the rest of the lamps.

Set alarm level
▪ With the configuration software tool, set the LFD Level1 and LFD Level2 alarm levels. See EFD/LFD screen.

Note
Choose the number of lamps in function of the alarm level you use. By default, 8 to 10 lamps.
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7.3 Remote control configuration: multiwire (option)

Examine if the equipment is set to multiwire remote control
1. On the HMI, push the MENU button to go to the Main menu.

2. Push the MAINT button to go to the Maintenance menu. See Maintenance menu.

3. Push the MORE button.

4. Push the → or ← buttons until the HMI shows the remote control mode.

5. Make sure that the remote control mode is ‘MULTIWIRE'.

6. If necessary, adjust the remote control mode.

Examine or adjust the input and output signals function assigned to terminals
1. Push the → or ← buttons until the HMI shows the multiwire configuration.

2. Check and adjust the signals if necessary. See Maintenance menu.

7.4 Remote control configuration: J-Bus (option)

Configure the slave number
1. On the HMI, push the MENU button to go to the Main menu.

2. Push the OPTIONS button to go to the Options menu.

3. Push the SLVNUM button to set the slave number of the equipment.

4. Push the SAVE button to save the slave number to the equipment.

Examine and adjust the configuration, if necessary
1. On the HMI, push the ESC button a number of times until the UI shows the Main menu.

2. Push the MAINT button to go to the Maintenance menu. See Maintenance menu.

3. Push the MORE button.

4. Push the → or ← buttons until the HMI shows the remote control mode.

5. Set the remote control mode to ‘JBUS'.

6. Set the applicable J-Bus protocol. The default value is ‘MCR2'.

7. Set the J-Bus mode to ‘485'.

7.5 Remote control configuration: ethernet (option)

Examine the remote control mode and adjust if necessary
1. On the HMI, push the MENU button to show the Main menu. See Display overview: Main screen.

2. Push the MAINT button to go to the Maintenance menu. See Maintenance menu.

3. Push the MORE button.

4. Push the → or ← buttons until the HMI shows the remote control mode.

5. Set the remote control mode to ‘JBUS'.

6. Set the applicable J-Bus protocol. The default value is ‘MCR2'.

7. Set the J-Bus mode to ‘Ethernet'.

Note
For the standard multiwire configuration, see Remote Control PCB.

You can only adjust the signals 6 to 15. The other signals are fixed.
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Examine the ethernet configuration and adjust if necessary
1. Push the → or ← buttons until the HMI shows the ethernet configuration.

2. Examine the parameters and adjust if necessary.

3. If you use a double ethernet connection, push the DOWN button until the HMI shows the ethernet configuration of the
second ethernet connection.

4. Examine the parameters and adjust if necessary.

7.6 CS configuration (option CS)

Tools
▪ PC with ethernet connector

▪ RJ45 cable (ethernet cable)

Connect the PC to the interface PCB (PCB1702)
1. Switch OFF the equipment. See Switch OFF the equipment.

2. Remove the front panel. See Remove panels.

3. Connect the ethernet cable (A) to the PC (B) and the interface PCB (C).

Figure 22: Select a 'useable IP addrSelect a 'useable IP address'ess'
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Examine the ethernet configuration and adjust if necessary
1. Simultaneously press button C2 on the HMI and switch ON the equipment. See Operation.

2. Wait until the LEDs on the HMI for local and remote will flash simultaneously. Now, you can configure the CS.

3. Release the button C2 on the HMI. Now, you can configure the CS.

4. On the PC, go to web address 192.168.1.22 to connect to the Circuit selector web-interface.

5. Change parameters where necessary.

6. Switch OFF the equipment. See Switch OFF the equipment.

7. Disconnect the ethernet cable.

8. Install the front panel. See Remove panels.

Configure the HMI
1. Switch ON the equipment. See Operation.

2. On the HMI, go to the maintenance menu.

3. Push the MORE button.

4. Push the → or ← buttons until the HMI shows the CSE mode screen.

5. Push the ON button.

6. Push the → or ← buttons until the HMI shows the multiwire configuration.

7. Set the values to the list below:

▪ J6.1: Circuit selector CCRON

▪ J6.2: OVER CURRENT

▪ J6.3: OPEN CIRCUIT

▪ J6.5: Circuit selector 2

▪ J6.7: EFD WARNING

▪ J6.8: EFD ERROR

▪ J7.1: HIGH TEMPERATURE ALARM

▪ J7.2: Circuit selector 6

Note
Press the 'Update' button after a change.

Note
The alarms OVER CURRENT and OPEN CIRCUIT are also used on the interface PCB to generate the error signal
'CCR FAULT'
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8.0 Operation

8.1 Switch ON the equipment
When you switch ON the equipment, it starts to produce the same output current that was valid before the equipment was
switched OFF.

To set a different output current, select another brightness step. See Select brightness step. For more information on the
produced output currents, see Used brightness steps.

A prerequisite for this procedure is that the equipment is switched off.

1. Set the manual switch (A) to the ON position.

▪ The equipment starts to produce the same output current that was valid before the equipment was switched OFF

▪ The HMI lights up

▪ The equipment starts in the same mode as it was stopped: Local or Remote mode

2. If the UI shows that the equipment is in the state OFF, push the ON button. The HMI shows the state ON.

3. To switch between Local and Remote mode, see Switch between local and remote mode.

8.2 Switch OFF the equipment
1. On the HMI, push the Local button. The screen now shows the state LOCAL.

2. Push the OFF button. The equipment goes to the mode OFF.

3. Switch OFF the power supply. See Switch OFF the power supply.

8.3 Switch OFF the power supply

1. Set the manual switch (A) to the OFF position.

2. Open the main switch on the main distribution board.

3. Disconnect the equipment from the series circuit.

WARNING
High voltage can be present on the system.

UM-6008, Rev. 2.9.0, 2026-02-20 77
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



8.4 Switch between local and remote mode
To control the equipment through the HMI, switch to the local mode.

To control the equipment with the remote control system, switch to the remote mode.

1. For Local mode, push the LOCAL button on the HMI. The HMI now shows the mode LOCAL.

2. For Remote mode, push the REMOTE button on the HMI. The UI now shows the mode REMOTE. You can change the
brightness step with the remote control device.

8.5 Select brightness step
1. Make sure that the equipment is powered ON, is in the ON state and in Local mode. See Operation.

2. To select a brightness step, push the corresponding number on the keypad. The equipment immediately starts to
produce the chosen brightness.

8.6 Adjust number of used brightness steps
1. Use the configuration software tool. See Output/Mains screen. For information on the used brightness steps, see Used

brightness steps.

2. Examine all brightness steps one by one. See Select brightness step . Examine if all light fittings have the same brilliancy
level. Go to the runway area to make a visual inspection.

8.7 Alarms
The HMI only shows information about errors that the equipment can detect. The equipment does not detect all possible
errors. You have to observe if the equipment operates correctly.

Local mode
An alarm occurs, the equipment switches OFF automatically.

▪ If you need to switch off the power supply to remove the cause of the alarm: The equipment starts to produce the same
output current that was valid before the equipment was switched OFF.

▪ If you do not need to switch off the power supply to remove the cause of the alarm: The equipment remains in the state
OFF. Only after you reset the alarm and push the ON button, does the equipment start to produce the same output
current that was valid before the equipment was switched OFF.

Remote mode
An alarm occurs, the equipment switches OFF automatically.

▪ If you need to switch off the power supply to remove the cause of the alarm: The equipment starts at the actual
multiwire/J-Bus command.

▪ If you do not need to switch off the power supply to remove the cause of the alarm: After you reset the alarm, the
equipment automatically goes to the actual multiwire command.

Reset an alarm
1. If the HMI does not show the alarm, push the Menu button to go to the Main Menu.

2. To go to the Alarms menu push the Alarms button.

3. To reset the alarm push the Reset button.

Note
The keypad keys on the HMI only operate when the equipment is in Local mode.
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Clear the error list
1. On the HMI, push the Menu button to go to the Main Menu.

2. Push the Alarms button to go to the Alarms menu.

3. Push the Clear alarms button. The equipment clears the error list.

8.8 Use Series CutOut (SCO)

8.8.1 Operation mode

The SCO has three operation modes:

Description Mode A Mode B Mode C

Purpose Normal operation

Equipment delivers current to the
connected series circuit

Maintenance operation

Equipment or series circuit can be
serviced safely

Measurement possible The series
circuit insulation relative to ground
can be measured

Diagram

Cover placement1

Handle position Horizontal Turned 90 degrees counter
clockwise from position A

Turned 90 degrees clockwise from
position A

Series circuit Connected to the equipment Shorted and grounded Disconnected from equipment,
shorted and connected to
measurement terminal

Equipment Delivers current to the series circuit Shorted and grounded Shorted and grounded

Microswitch2 Activated. Equipment is ON Not activated. Equipment is OFF Activated. Equipment is ON

WARNING
Always wear protective gloves and shoes when working with the equipment or series circuit.

1Only the three positions shown can be used. In another position, the cover fits correctly.
2When the cover is closed, the micro switch is activated. When the cover is open, the microcircuit is deactivated and the equipment shuts
down.
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8.8.2 Adjust operation mode

Remove the cover
1. Open the lock (A).

2. Remove the cover (B). Use the handle.

Set operation mode
1. Install the cover (B). See the cover placement in Operation mode.

2. Close the lock (A).

8.9 Operation mode
A series circuit with non-linear loads can be unstable. If the system is unstable, follow the procedure below.

1. On the HMI, push the MENU button to go to the Main menu.

2. Push the OPTIONS button to go to the Options menu.

3. Push the MODE button to go to the Mode menu.

4. Select the applicable mode: Normal is the factory default. Inductive is for cases where the current regulation is under
the influence of inductive load and becomes unstable. The HMI now shows the Main screen.

Note
The equipment automatically detects if the inductive mode is required. The alarm message 'DC BUS VOLTAGE TOO
HIGH' means that the series circuit is unstable.
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Note
The equipment has these limitations in inductive mode:

▪ The power is limited to 85%

▪ The LFD measurement is not active

▪ In normal mode the equipment limits all current peaks higher than 7 A in less than 10 ms, in inductive mode the
current peak can reach 9 A

▪ The output waveform is not a perfect sinusoidal wave.
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9.0 Troubleshooting

9.1 Preliminary checks
Before you do any adjustments on the equipment, check:

▪ the alarm and back-indication signals on the display and/or remote control

▪ if the power supply to the equipment is within the acceptance limit

▪ if the fused input switches and auxiliary fuses are operational

▪ if the input fuses and auxiliary fuses work normally

▪ if all connectors are correctly in place

▪ that no components show burned marks.

▪ if the input circuit breaker is in the ‘open' position

▪ wires are not interrupted or damaged.

9.2 Troubleshooting guide

9.2.1 Fault: Equipment does not turn ON

Table 11: Equipment does not turn ON

Problem Possible cause Possible solution

No display indications A problem with the power supply on
the diode bridge PCB

▪ Examine the transformer on the diode bridge

▪ If necessary, replace the IGBT power bridge that
contains the diode bridge PCB

See Diode bridge + sensing PCB (EPS476 / EPS507)
replacement, small and stackable cabinet

▪ Examine the external 400 VAC/24VAC transformer

▪ Replace the external transformer, if necessary

The main switch is damaged Replace the main switch. See Manual switch replacement

The input line filter is damaged Replace the line filter. See Line filter replacement

The main contactor is damaged Replace the main contactor. See Main contactor
replacement, small cabinet or Main contactor replacement,
big cabinet

WARNING
Do not troubleshoot unless you have read and understood all the information in the chapter Safety and you are
qualified to work on high-voltage systems.

▪ Set the equipment to Local mode

▪ Set the equipment to the brightness step OFF before you examine the series circuit

▪ Turn Off the main switch of the equipment

If you do not follow the steps above, an increase of the power input can start an on cycling and restart the equipment.
This results in a possible lethal output voltage.

Note
For a list of errors, see CCR status screen.
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Table 11: Equipment does not turn ON

Problem Possible cause Possible solution

Replace the power supply PCB. See Power supply PCB
(EPS480) replacement

Replace the CPU PCB. See CPU PCB (EPS479) replacement

9.2.2 Fault: Equipment does not go to the ON state

Table 12: Equipment does not turn ON

Problem Possible cause Possible solution

Local mode:

▪ The display shows an
alarm

▪ The red lamp on top of
the equipment goes on

Remote mode:

▪ The red lamp on top of
the equipment goes on

One of the panels is open Close the panel

▪ Examine the fuses on power supply PCB

▪ Replace the fuses if necessary.

See Fuses on the power supply PCB (EPS480)
replacement

▪ Examine the CPU PCB

▪ Replace the CPU PCB if necessary

See CPU PCB (EPS479) replacement

The main contactor is enabled when
the equipment is in the OFF state
when there is no command from the
CPU PCB. Or

The main contactor is not enabled
when there is a command from the
CPU PCB

▪ Examine the main contactor

▪ Replace the main contactor if necessary

See Main contactor replacement, small cabinet or
Main contactor replacement, big cabinet

Examine the wiring connections

▪ Examine the CPU PCB

▪ Replace the CPU PCB if necessary

See CPU PCB (EPS479) replacement

One or more phases is not present ▪ Examine the fuses on power supply PCB

▪ Replace the fuses if necessary

See Fuses on the power supply PCB (EPS480)
replacement

▪ Examine the external 400 VAC/24VAC transformer

▪ Replace the external transformer, if necessary

One of the fuses for the phases is
broken

▪ Examine the main fuses

▪ Replace the broken fuse. See Main fuses replacement
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9.2.3 Fault: Equipment turns ON but suddenly de-energizes

Table 13: Equipment turns ON but suddenly de-energizes

Problem Possible cause Solution (See)

After you press the ON button,
record these problems:

Local mode:

▪ The display shows an
alarm

▪ The red lamp on top of
the equipment goes on

Remote mode:

▪ The red lamp on top of
the equipment goes on

The input AC line delivers less than
360 VAC

Examine the input VAC line

▪ Examine the external 400 VAC/24VAC transformer

▪ Replace the external transformer, if necessary

Open circuit Examine the connection of the high voltage cable to the
field connection unit and to the power supply transformer

▪ Examine the output measure PCB.

▪ Replace the output measure PCB, if necessary. See
Output measure PCB (EPS442) replacement

Overcurrent ▪ Examine the output measure PCB

▪ Replace the output measure PCB, if necessary. See
Output measure PCB (EPS442) replacement

A malfunction of the communication
of the output measurement PCB

The current on the primary winding
of the power supply transformer is
too high

▪ Examine the IGBTs

▪ If necessary, replace the IGBT power bridge that
contains the IGBT. See IGBT replacement, stackable
and small cabinetor IGBT replacement, big cabinet

▪ Examine the CPU PCB

▪ Replace the CPU PCB if necessary

See CPU PCB (EPS479) replacement

▪ Examine the IGBT PCB

▪ If necessary, replace the IGBT power bridge that
contains the IGBT PCB. See IGBT replacement,
stackable and small cabinet or IGBT replacement, big
cabinet

9.2.4 Fault: equipment does not produce requested output current

Table 14: Equipment does not produce the requested output current

Problem Possible cause Solution (See)

The red lamp on top of the
equipment goes on

The equipment does not
operate correctly

▪ Examine the IGBT modules

▪ If necessary, replace the IGBT power bridge that contains
the IGBT module

See IGBT replacement, stackable and small cabinet or IGBT
replacement, big cabinet

▪ Examine the output measure PCB

▪ Replace the output measure PCB, if necessary. See Output
measure PCB (EPS442) replacement

▪ Examine the IGBT PCB

▪ If necessary, replace the IGBT power bridge that contains
the IGBT PCB. See IGBT replacement, stackable and small
cabinet or IGBT replacement, big cabinet

9.3 Checks and measurements
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9.3.1 Measure input voltage
1. Make sure that the main switch is OFF.

2. Make sure that the input supply cables that come from the mains distribution panel are only connected to the
equipment you want to measure.

3. Switch on the mains distribution to feed the equipment you want to measure.

4. Make sure that all connectors are securely tightened.

5. Measure the input voltage (V) to the equipment. Use a True RMS Multimeter.

6. Check the nameplate of the equipment and make sure that the input voltage is compatible with the equipment.

9.3.2 Measure output current
1. Make sure that main switch is OFF.

2. Install a calibrated True RMS multimeter with a current clamp in the output circuit.

3. Switch on the equipment and set the equipment to the highest brightness step. See Select brightness step.

4. Read the output current from the True RMS multimeter.

5. Make sure that the measurement is accurate. Calibrate the output current again if necessary.

9.3.3 Check fuse breaker and voltage of switch board
1. Make sure that the main switch is OFF.

2. Check the nameplate of the equipment to make sure that the fuse breaker voltage and the current rating of the
switchboard is compatible with the equipment. Allowed variance by standards:

▪ IEC: +10%

▪ FAA: ±10%

3. Set the main switch to ON.

4. Measure the voltage (V) of the switchboard. Use a calibrated True RMS multimeter.

9.3.4 Calculate minimum insulation resistance of series circuit
1. Calculate the minimum insulation resistance of the series circuit. See Calculate minimum insulation resistance of series

circuit.

2. Make sure that the calculated values are higher than the values measured during commissioning.

9.3.5 Calculate resistance of series circuit
Rprim = ρ x L/A + y x 0.1212

Where:

▪ Rprim = resistance of the series circuit in Ohm

▪ ρ = 18 x 10-3 (Ohm x mm2)/m

▪ L = length of the circuit in m

▪ A = section of the cable in mm2

▪ y = number of series transformers in the circuit

Example:

circuit length is 8000 m

cable section is 6 mm2

number of series transformers is 122

Then Rprim = (18 x 10-3) x 8000/6 + 122 x 0.1212 = 36.7 Ohm
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9.3.6 Measure cable capacitance
Measure the cable capacitance towards the ground as follows:

1. Make sure that the main switch is OFF.

2. Connect a multimeter to the regulator output cable. Use a Multimeter that has an internal resistance of 10 MOhm.

3. Disconnect the 500 V DC power cable to the EFD module. The Multimeter now measures the discharge time of the cable
capacitance from 400 V DC to 147 V DC.

If the cable capacitance is 1 pF, the measured voltage decreases from 400 V DC to 147 V DC (=0.37x400) in approximately 10
seconds.

If the voltage you measure with the LFD module connected is already 330 V DC, the cable leakage resistance is approximately
10 MOhm. In this case, the discharge time is approximately 5 seconds for a cable capacitance of 1 pF.
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10.0 Maintenance

10.1 Preventive maintenance schedule
Table 15: Preventive maintenance schedule

Frequency Check Action

In accordance with ICAO
Aerodrome Design Manual Part 9
Airport Maintenance practices or
in accordance with local
maintenance regulations. Adapt
the maintenance frequency to the
local conditions

Examine the operation of the
equipment on all brightness steps
on all readings

Use a PC to log the data, if required

Input voltage If the input voltage is not within the limits, tell the power
company to adjust the voltage. Make sure that you do the
necessary actions to align the input voltage with the input
limitations

Output current. Use a calibrated
True RMS multimeter and/or a
current clamp.

If the output current is not within tolerance, calibrate the
output current again

Visually:

▪ that the wiring of the
equipment and the circuit is
not damaged

▪ for rust spots and general
damage

▪ the housing for dust
accumulation

▪ all signs on the equipment
for legibility and damage

▪ Repair damaged or loose wires

▪ Replace damaged components

▪ Clean and repair rust spots

▪ Clean the inside of the equipment with an dry air
blower

If the electrical connections (e.g.
input connections, output
connections) are tightened
correctly

Make sure that all connections are tightened

10.2 Part replacement

WARNING
▪ Only personnel authorized to work on high-voltage equipment can do maintenance work on the equipment.

▪ Operate the equipment under local control when you do maintenance work on the equipment to prevent the
equipment from being accidentally switched ON.

▪ Follow all local safety procedures.

▪ Make sure that you have obtained the necessary permissions according to the local operation procedures and
procedures regarding HV equipment.

WARNING
▪ Make sure you have read and understood all safety procedures and standards related to this equipment. See

Safety.

▪ Make sure you switch OFF the power to the equipment. See Switch OFF the power supply.

▪ Make sure you switch OFF the manual switch to remove all power to the equipment.
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10.2.1 Required tools

Measurement tools
▪ True RMS Multimeter

▪ Multimeter

▪ Insulation tester "Megger" 500 V or 1000 V

▪ Clamp or A-meter true RMS scale 10 and 30 A

Other tools
▪ Standard electrical and mechanical tool kit

▪ Screwdrivers with protection up to 1000 V

▪ Spanner set (ring or socket spanners)

▪ Allen keys 4 and 6 mm

▪ Torque screwdrivers (2 - 10 Nm) and adaptors

▪ Short, slotted screwdriver

▪ Magnet rod for collecting loose items

▪ Angle socket wrench

CAUTION
While you carry out maintenance:

▪ Do not drop screws or nuts inside the equipment cabinet. Collect loose nuts and screws immediately.

▪ To identify all cables you disconnect, label the cables.

▪ Make sure that you change the correct PCB.

▪ You have saved the equipment settings as a profile. To do this in the configuration software tool, see Install and
operate the configuration software tool.

▪ Put in the new parts exactly the same way as the parts you removed.

▪ After you replace a part, test the equipment to make sure it is replaced correctly.

Note
Refer to the electrical schemes inside the equipment cabinet for the connection schemes.

CAUTION
The output voltage of the 30 kVA / 6.6 A equipment can reach approximately 4600 V at full load. An isolating
measurement transformer for use on the 5000 V AC line is recommended.

CAUTION
The current regulation is +/- 1%. To make an acceptable readjustment of the output current, the accuracy of the
meter must be better than 0.5% for the adjusted value.

Constant Current Regulator
Maintenance

90
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



10.2.2 CPU PCB (EPS479) replacement

For parts, see Parts list.

▪ CPU PCB

▪ Firmware

Remove panel
▪ Remove the front panel. See Remove panels.

Disconnect
1. Disconnect the connectors and the wires (A).

2. Remove the fasteners (B).

3. Remove the CPU PCB (C).

Install
1. Install the new CPU PCB.

2. Install the fasteners.

3. Connect all the wires.

Update the firmware
1. Update the firmware. See Firmware update.

2. Install the front panel. See Remove panels.

10.2.3 CS PCB (PCB1619) replacement (option CS)
For parts, see Parts list.

▪ CS PCB

CAUTION
If you install an OVP version of the CPU PCB, make sure that the diode bridge PCB is also an OVP version.

If you install a non-OVP version of the CPU PCB, make sure that the diode bridge PCB is also a non-OVP version.

Make sure that you update the correct firmware. The firmware code for an OVP version of the PCB ends with an 'e'.

CAUTION
Connect the keyboard cable with the green side down.
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Figure 23: CS PCBCS PCB

1. Switch OFF the power supply. See Switch OFF the equipment.

2. Remove the rear panel. See Remove panels.

3. Disconnect the cables from the CS PCB that you need to replace (A).

4. Remove the fasteners (B).

5. Replace the CS PCB.

6. Install the fasteners (A).

7. Connect the cables to the connectors.

8. Install the rear panel.

10.2.4 CS Relay replacement (option CS)
For parts, see Parts list.

▪ CS relay

1. Switch OFF the power supply. See Switch OFF the equipment.

2. Remove the rear panel. See Remove panels.

3. Remove the CS PCB. See CS PCB (PCB1619) replacement (option CS).

4. Disconnect the cables (A) from the output terminals.

5. Remove the fasteners (B).

6. Replace the CS relay (C).

7. Install the fasteners.

8. Connect the cables to the output terminals.

9. Install the CS PCB. See CS PCB (PCB1619) replacement (option CS).
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10.2.5 Diode bridge + sensing PCB (EPS476 / EPS507) replacement, small and
stackable cabinet

For parts, see Parts list .

▪ Diode bridge + sensing PCB

Prepare
▪ Remove the front panel by way of preparation. See Remove panels.

Remove

1. Disconnect the wires and connectors (A).

2. Remove the fasteners (B).

3. Remove the diode bridge + sensing PCB (C).

Install

1. Wipe clean the copper plate (A).

2. Apply an even layer of conductive paste on the copper plate.

3. Install the new diode bridge on the new sensing PCB.

CAUTION
If you install an OVP version of the CPU PCB, make sure that the diode bridge + sensing PCB is also an OVP version.

If you install a non-OVP version of the CPU PCB, make sure that the diode bridge + sensing PCB is also a non-OVP
version.

Make sure that you update the correct firmware. The firmware code for an OVP version of the PCB ends with an 'e'.

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.
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4. Make sure that the diode bridge makes good contact with the heatsink.

5. Connect the wires.

6. Tighten the fasteners (D). Apply a torque of 2 Nm.

7. Install the front panel. See Remove panels.

8. On the HMI, check the firmware version. The firmware code for an OVP version of the PCB ends with an 'e'.

9. If the firmware version is not correct, update the firmware version. See Firmware update.

10.2.6 Diode bridge and sensing PCB (EPS476) replacement, big cabinet

For parts, see Parts list.

▪ Diode bridge and sensing PCB

Prepare
:

▪ Remove the lower front panel. See Remove panels.

Remove sensing PCB
1. Disconnect the wires and connectors (A).

2. Remove the fasteners (B).

3. Remove the sensing PCB (C).

CAUTION
If there is a washer or a screw between the diode bridge and the heatsink, the heat dissipation is not sufficient.

CAUTION
Carefully put the wire (B) through the sensing transformer (C). The sensing transformer is easily damaged.

CAUTION
If you install an non-OVP version of the CPU PCB, make sure that the diode bridge and sensing PCB are also an non-OVP
version.

Make sure that you update the correct firmware. The firmware code for an OVP version of the PCB ends with an 'e'.

If you install an non-OVP version of the CPU PCB, make sure that the diode bridge and sensing PCB is also an non-OVP
version.

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.
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Remove diode bridge
:

1. Remove the fasteners (A).

2. Disconnect the wires (B).

3. Remove the fasteners (C).

4. Remove the diode bridge (D).
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Install
1. Wipe clean the heat sink where you install the new diode bridge.

2. Apply an even layer of conductive paste on the back side of the new diode bridge.

3. Install the new diode bridge.

4. Make sure that the diode bridge makes good contact with the heatsink.

5. Tighten the fasteners (A). Apply a torque of 4 Nm.

6. Install the new sensing PCB.

7. Connect all the wires to the sensing PCB.

8. Tighten the fasteners (B). Apply a torque of 2 Nm.

Finish
1. Install the lower front panel. See Generic panels.

2. On the HMI, check the firmware version. The firmware code for an OVP version of the PCB ends with an 'e'.

3. If the firmware version is not correct, update the firmware version. See Firmware update.

10.2.7 Display and keyboard replacement
For parts, see Parts list.

▪ Display/keyboard panel

1. Remove the display/keyboard panel. See Remove panels.

2. Install the new display/keyboard panel. See Remove panels.

10.2.8 Fuses on the power supply PCB (EPS480) replacement
For parts, see Parts list.

▪ Fuses. See also Protection devices.

1. Remove the lower front panel. See Remove panels.

2. To replace, push, turn counterclockwise and remove the fuse (A). If only one fuse is broken, replace only the broken
fuse.

CAUTION
If there is a washer or a screw between the diode bridge and the heatsink, the heat dissipation is not sufficient.
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3. Install the new fuse.

4. Install the lower front panel. See Remove panels.

10.2.9 HMI SIN PCB (PCB1694) replacement (option CS)
For parts, see Parts list.

▪ HMI SIN PCB

1. Remove the display/keyboard panel. See Remove panels.

2. Disconnect the connectors and the wires (A).

3. Remove the fasteners (B).

4. Remove the HMI SIN PCB (C).

5. Install the new remote control PCB.

6. Connect all the wires.

7. Install the display / keyboard panel. See Remove panels.

10.2.10 IGBT replacement, stackable and small cabinet
For parts, see Parts list.

▪ IGBT

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.

The illustrations for this procedure show the situation for the 2.5 kVA and 10 kVA cabinets.

CAUTION
Before switching ON the output of the CCR, the "IGBT Test" function must be activated. This reduces the risk of IGBT
damage in case of incorrect installation. If the start-up is successful, the "IGBT Test" function shall be deactivated to
allow normal operation of the CCR.
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Remove panel
▪ Remove the front panel. See Remove panels.

Remove 1
1. Remove the fasteners (A).

2. Remove the capacitor plate (B).

3. Remove the IGBT PCB. See IGBT PCB (EPS477 / EPS 478) replacement, small cabinet.

Remove 2
1. Disconnect the wire (A).

2. Remove the fasteners (B).

3. Remove the IGBT (C).

Prepare the IGBT
▪ Make sure that spring number 7 (A) of the IGBT is removed. Once a spring has been removed, it cannot be re-installed.
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Install 1
1. Wipe clean the heat sink below the IGBT (A).

2. Apply an even layer of conductive paste on the rear of the IGBT (the side that touches the heat sink).

3. Tighten the fasteners (B) crosswise. Apply a torque of 4 Nm.

Install 2
1. Install the IGBT PCB. See IGBT PCB (EPS477 / EPS 478) replacement, small cabinet.

2. Install the capacitor plate.

3. Connect the wires.

4. Install the fasteners (A). Apply a torque of 4 Nm.

5. Install the front panel. See Remove panels.

10.2.11 IGBT replacement, big cabinet
For parts, see Parts list.

▪ IGBT

Note
▪ The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one

component breaks, replace the entire IGBT power bridge.

▪ The procedure shows the IGBT at the right-hand side. The procedure for the IGBT at the left-hand side is similar.

CAUTION
Before switching ON the output of the CCR, the "IGBT Test" function must be activated. This reduces the risk of IGBT
damage in case of incorrect installation. If the start-up is successful, the "IGBT Test" function shall be deactivated to
allow normal operation of the CCR.
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Remove

1. Remove the IGBT PCB. See IGBT PCB (EPS496) replacement, big cabinet.

2. Remove the fasteners (A).

3. Remove the fasteners (B).

4. Remove the IGBT (C).

Install

1. Wipe clean the heat sink below the new IGBT (A). Apply an even layer of conductive paste on the rear of the IGBT (the
side that touches the heat sink).

2. Install the IGBT.

3. Install the fasteners (B). Apply a torque of 4 Nm.

4. Install the fasteners (C). Apply a torque of 4 Nm.

5. Install the IGBT PCB. See IGBT PCB (EPS496) replacement, big cabinet.

10.2.12 IGBT PCB (EPS477 / EPS 478) replacement, small cabinet
For parts, seeParts list.

▪ IGBT PCB

CAUTION
When you tighten the fasteners, only apply force vertically. Use an allen key screwdriver or an allen key handle instead
of a socket wrench or a ratchet. Sideways force can damage components.

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.

The illustrations for this procedure show the situation for the 2.5 kVA and 10 kVA cabinets.
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Remove panel
▪ Remove the front panel. See Remove panels.

Disconnect
1. Make sure that spring number 7 (A) of the IGBT is removed.

Once a spring is removed, it cannot be installed again.

2. Disconnect the connectors and the wires (A).

3. Remove the fasteners (B).

4. Remove the IGBT PCB (C).

Install

1. Make sure that spring number 7 (A) of the IGBT is removed. Once a spring has been removed, it cannot be reinstalled

2. Install the new IGBT PCB.

3. Connect all the wires.

4. Install the front panel. See Remove panels.

CAUTION
Before switching ON the output of the CCR, the "IGBT Test" function must be activated. This reduces the risk of IGBT
damage in case of incorrect installation. If the start-up is successful, the "IGBT Test" function shall be deactivated to
allow normal operation of the CCR.

CAUTION
When you tighten the fasteners, only apply force vertically. Use an allen key screwdriver or an allen key handle instead
of a socket wrench or a ratchet. Sideways force can cause the components to get damaged.
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10.2.13 IGBT PCB (EPS496) replacement, big cabinet
For parts, see Parts list.

▪ IGBT PCB

Remove panel
▪ Remove the lower front panel. See Remove panels.

Remove

1. Disconnect the wires (A).

2. Remove the fasteners (B).

3. Remove the capacitors (C).

4. Remove the fasteners (D).

5. Remove the IGBT PCB.

Remove the spring from the IGBT
▪ Make sure that spring number 7 (A) of the IGBT is removed. Once a spring has been removed, it cannot be reinstalled.

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.

The procedure shows the IGBT PCB at the right-hand side. The procedure for the IGBT PCB at the left-hand side is
similar.

CAUTION
Before switching ON the output of the CCR, the "IGBT Test" function must be activated. This reduces the risk of IGBT
damage in case of incorrect installation. If the start-up is successful, the "IGBT Test" function shall be deactivated to
allow normal operation of the CCR.
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Install

1. Install the new IGBT PCB (A) on the IGBT.

2. Install the fasteners (B) crosswise. Apply a torque of 4 Nm.

3. Install the capacitors (C).

4. Install the fasteners (D). Apply a torque of 4 Nm.

5. Connect the wires (E).

10.2.14 Input filter replacement, stackable cabinet
For parts, see Parts list.

▪ Input filter

▪ Output filter

1. Remove the top panel. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the parts of the input filter (C).

CAUTION
When you tighten the fasteners, only apply force vertically. Use an alien key screwdriver or an allen key handle instead
of a socket wrench or a ratchet. Sideways force can cause the components to get damaged.

Note
Always replace the input filter and the output filter together.

The number of filters and capacities can be different from the illustrations, depending on the output power.
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Install:

1. Install the new parts of the input filter (A).

2. Tighten the fasteners (B). Apply a torque of 3 Nm.

3. Connect the wires.

4. Tighten the fasteners (C). Apply a torque of 6 Nm.

5. Install the top panel. See Remove panels.

10.2.15 Input filter replacement, small (up to 10 kVA) cabinet
For parts, see Parts list.

▪ Input filter

▪ Output filter

Remove:

1. Remove the side panels. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the input filter plate (C).

Note
Always replace the input filter and the output filter together.

The number of filters and capacities can be different from the illustrations, depending on the output power.
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Install:

1. Install the new input filter plate (A).

2. Tighten the fasteners (B).

3. Install the wires.

4. Tighten the fasteners (C). Apply a torque of 6 Nm.

5. Install the side panels. See Remove panels.

10.2.16 Input filter replacement, small cabinet (15 kVA) and big cabinet
For parts, see Parts list.

▪ Input filter

▪ Output filter

1. Remove the side panels. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the complete input filter (C).

Install:

Note
Always replace the input filter and the output filter together.

The number of filters and capacities can be different from the illustrations, depending on the output power.
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1. Install the new complete input filter (A).

2. Tighten the fasteners (B).

3. Install the wires.

4. Tighten the fasteners (C). Apply a torque of 6 Nm.

5. Install the side panels. See Remove panels.

10.2.17 Interface PCB (PCB1702) replacement (option CS)
For parts, see Parts list.

▪ Interface PCB

1. Switch OFF the power supply. See Switch OFF the equipment.

2. Remove the front panel. See Remove panels.

3. Disconnect the cables from the CS PCB (A).

4. Remove the fasteners (B).

5. Replace the CS PCB.

6. Install the fasteners (A).

7. Connect the cables to the connectors.

8. Install the front panel of the CS cabinet.

10.2.18 Lightning arrestors replacement, equipment with SCO or SCB
For parts, see Parts list.

▪ Lightning arrestors

Note
The number of lightning arrestors can be different from the illustrations, depending on the output power.
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1. Remove the side panels. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the lightning arrestors assembly (C).

5. Install the new lightning arrestors assembly.

6. Install the wires.

7. Install the side panels. See Remove panels.

10.2.19 Line filter replacement
For parts, see Parts list.

▪ Line filter

1. Remove the side panels. See Remove panels.

2. Remove the lower rear panel. See Remove panels.

3. Disconnect the wires (A).

4. Remove the fasteners (B).

5. Remove the line filter (C).

6. Install the new line filter.

7. Install the wires.

8. Install the lower rear panel. See Remove panels.

9. Install the side panels. See Remove panels.

10.2.20 Main contactor replacement, small cabinet

For parts, see Parts list.

▪ Main contactor

WARNING
Make sure that you have switched OFF the power to the equipment. See Switch OFF the power supply.
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1. Remove the lower front panel. See Remove panels.

2. Loosen the screws (A).

3. Disconnect the wires (B).

4. Remove the main contactor (C). Use a screwdriver as a lever to release the manual switch from the rail (D).

Install

1. Install the new main contactor.

2. Connect all the wires.

3. Tighten the screws of the main power cables (A). Apply a torque of 5 Nm.

4. Tighten the screws of the auxiliary power cables (B). Apply a torque of 1.7 Nm.

5. Install the lower front panel. See Remove panels.

10.2.21 Main contactor replacement, big cabinet
For parts, see Parts list.

▪ Main contactor

1. Remove the main front panel. See Remove panels.

WARNING
Make sure that you switched OFF the power to the equipment. See Switch OFF the power supply
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Disconnect

1. Loosen the screws (A).

2. Disconnect the wires (B).

3. Remove the main contactor (C). Use a screwdriver as a lever to release the manual switch from the rail (D).

Install

1. Install the new main contactor.

2. Connect all the wires.

3. Tighten the screws of the main power cables (A). Apply a torque of 4 Nm.

4. Tighten the screws of the auxiliary power cables (B). Apply a torque of 1.7 Nm.

5. Install the lower front panel. See Remove panels.

10.2.22 Main fuses replacement
For parts, see Parts list.

▪ Fuses. See also Protection devices.

1. Remove the lower front panel. See Remove panels.

2. Open the fuse holder (A).

3. Replace the fuse (B).

4. Close the fuse holder.

5. Install the lower front panel. See Remove panels.
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10.2.23 Manual switch replacement

For parts, see Parts list.

▪ Manual switch

1. Remove the lower front panel. See Remove panels.

2. Loosen the screws (A).

3. Disconnect the wires (B).

4. Remove the manual switch (C). Use a screwdriver as a lever to release the manual switch from the rail (D).

Install

1. Install the new manual switch.

2. Connect all the wires.

3. Tighten the screws (A). Apply a torque of 4 Nm.

4. Install the lower front panel. See Remove panels.

WARNING
Make sure to switch OFF power to the equipment. See Remove panels.
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10.2.24 Output filter replacement, stackable cabinet
For parts, see Parts list.

▪ Input filter

▪ Output filter

1. Remove the top panel. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the parts of the output filter (C).

Install:

1. Install the new parts of the output filter (A).

2. Tighten the fasteners (B). Apply a torque of 3 Nm.

3. Connect the wires.

4. Tighten the fasteners (C). Apply a torque of 6 Nm.

5. Install the top panel. See Remove panels.

10.2.25 Output filter replacement, small (up to 10 kVA) cabinet
For parts, see Parts list.

▪ Input filter

▪ Output filter

Note
Always replace the input filter and the output filter together.

The number of filters and capacities can be different from the illustrations, depending on the output power.
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1. Remove the side panels. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the output filter plate (C).

Install:

1. Install the new output filter plate (A).

2. Tighten the fasteners (B).

3. Install the wires.

4. Tighten the fasteners (C). Apply a torque of 6 Nm.

5. Install the side panels. See Remove panels.

10.2.26 Output filter replacement, small cabinet 15 kVA and big cabinet
For parts, see Parts list.

▪ Input filter

▪ Output filter

Note
Always replace the input filter and the output filter together.

The number of filters and capacities can be different from the illustrations, depending on the output power.

Note
Always replace the input filter and the output filter together.

The number of filters and capacities can be different from the illustrations, depending on the output power.
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1. Remove the side panels. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the complete output filter (C).

Install:

1. Install the new complete output filter (A).

2. Tighten the fasteners (B).

3. Install the wires.

4. Tighten the fasteners (C). Apply a torque of 6 Nm.

5. Install the side panels. See Remove panels.

10.2.27 Output measure PCB (EPS442) replacement
Parts: see Parts list.

▪ Output measure PCB

Remove panels
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1. Remove the upper rear panel. See Remove panels.

2. Remove the screws (A).

3. Remove the box panel (B).

Disconnect

1. Disconnect the wires and connectors (A).

2. Remove the fasteners (B).

3. Remove the output measure PCB (C).

Install
1. Install the new output measure PCB.

2. Install the wires and connectors.

3. Install the box panel.

4. Install the upper rear panel. See Remove panels.

10.2.28 Power supply PCB (EPS480) replacement
For parts, see Parts list.

▪ Power supply PCB

1. Remove the front panel. See Remove panels.

2. Disconnect the connectors and the wires (A).

3. Remove the fasteners (B).

4. Remove the power supply PCB (C).

5. Install the new power supply PCB.

6. Connect all the wires.

7. Install the front panel. See Remove panels.
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10.2.29 Remote control PCB (EPS495 or EP00051) replacement
For parts, see Parts list.

▪ Remote control PCB or remote control PCB SIN

1. Remove the upper rear panel. See Remove panels.

2. Disconnect the connectors and the wires (A).

3. Remove the fasteners (B).

4. Remove the remote control PCB (C).

5. [Only applicable to EPS495.] Set the dip-switches of the new remote control PCB. See Remote Control PCB.

6. Install the new remote control PCB.

7. Connect all the wires.

8. Install the upper rear panel. See Remove panels.

10.2.30 Series CutOut (SCO) replacement (option)
For parts, see Parts list.

▪ Series CutOut (SCO)

Note
The procedure is similar for the replacement of the remote conrol PCB SIN.

CAUTION
Depending on the configuration of the equipment, other wires need to be connected. These can be different from
the illustration above.
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Prepare
1. Switch Off the power supply. See Switch OFF the power supply.

2. Make sure that the circuit is earthed.

3. Open the lock (A).

4. Remove the cover (B). Use the handle.

Remove

1. Loosen the screws (A1).

2. Remove the series circuit cables from the earthing bar (A2).

3. Disconnect the series circuit cables (A).

4. Loosen the screws (B1).

5. Disconnect the output cables (B).

6. Loosen the screw (C1)

7. Disconnect the earthing wire (C).

8. Remove the bolts (D).

9. Remove the SCO.

Connect the micro switch

1. Disconnect the cables to the micro switch (A).

2. Connect the cables to the micro switch (A) in the new SCO.
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Install

1. Install the new SCO.

2. Install the bolts (D).

3. Connect the earthing wire (C). Use the screw connection (C1).

4. Connect the output cables (B).

5. Tighten the screws B1.

6. Connect the series circuit cables (A).

7. Tighten the screws (A1).

8. Connect the wires to the earthing bar (A2).

▪ Make the connection of the shield of the cable to the earthing bar.

▪ If there is no shield on the cable, connect a clamp to the outside of the cable.

Finish

▪ Install the cover of the SCO (A).

10.2.31 Series Connection Box (SCB) replacement (option)
For parts, see Parts list.

▪ Series Connection Box (SCB)

Prepare
1. Switch OFF the power supply. See Switch OFF the power supply.

2. Make sure that the circuit is earthed.
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Remove panel

1. Loosen the fasteners (A).

2. Remove the box panel (B).

Remove

1. Loosen the screws (A).

2. Disconnect the series circuit cables (B).

3. Disconnect the wires and connectors (C).

4. Loosen the screws (D).

5. Carefully remove the SCB (E).

Install
1. Install the new SCB.

2. Put the series circuit cables through the stress-relief clamps.

3. Tighten the screws of the stress-relief clamps.

4. Install all the wires and connectors.

5. Install the box panel.

10.3 Remove panels
The panels of the equipment can be removed for installation or maintenance procedures.

Constant Current Regulator
Maintenance

118
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



10.3.1 Generic panels

Remove panel

1. Set the manual switch to the Off position.

2. Remove the screws (A) from the bottom to the top.

3. Carefully remove the panel (B).

Disconnect wires

▪ Disconnect the green/yellow earthing wires. The wires have a fast-on connector.

WARNING
▪ Do not operate the equipment with any of the panels removed

▪ Always connect the earthing wires before you install the panels

▪ The panels can be heavy, especially the side panels

▪ Do not change or lock the panel switches. A panel switch sees if a panel is installed or not.

Note
The panels differ in size and number of screws. The illustrations below show the principle.

WARNING
The panels are heavy. Also, the momentum of the panel can cause damage to the panel and the screws if you
remove the top screws first.

CAUTION
Take care to not damage cables and connectors.
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10.3.2 Remove the display / keyboard panel of the small cabinet

Disconnect HMI

1. Remove the front panel. See Generic panels.

2. Disconnect the wires (A) to the HMI from the CPU PCB (B).

3. Disconnect the earthing wire (C).

Remove panel

1. Remove the top panel. See Top panel (small cabinet) .

2. Remove the screws (A).

3. Carefully remove the panel (B).

CAUTION
Take care not to damage cables and connectors.
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10.3.3 Remove the display / keyboard panel of the big cabinet

Disconnect HMI

1. Remove the lower front panel. See Top panel (small cabinet).

2. Disconnect the wires (A) to the HMI from the CPU PCB (B).

3. Disconnect the earthing wire (C).

Remove panel

1. Remove the screws (A).

2. Carefully remove the panel (B).

10.3.4 Remove the display / keyboard panel of a cabinet with a CS (option CS)
Open panel:

1. Remove the screws (A).

CAUTION
Take care not to damage cables and connectors.
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2. Open the panel (B) downwards.

Disconnect HMI:

1. Disconnect the wires (A) to the HMI from the CPU PCB (B).

2. Disconnect the earthing wire (C).

Remove panel:

1. Remove the screws (A).

2. Remove the panel (B).

10.3.5 Top panel (small cabinet)

Disconnect HMI

1. Remove the front panel. See Generic panels .

2. Disconnect the wires (A) to the HMI from the CPU PCB (B).

3. Disconnect the earthing wire (C).
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Remove

1. Remove the screws (A).

2. Remove the top panel (B).

Disconnect wires

▪ Disconnect the green/yellow earthing wires. The wires have a fast-on connector.

10.4 Firmware update

Tools
▪ PC with serial port connection

▪ Firmware update dongle: ‘Pin to Pin DB9P & DB9S cable'

▪ Correct firmware upload file

Firmware update procedure
1. Install the software to upload the firmware. See Install the software to upload the firmware.

2. Change the SD flash file paths, if necessary. See Change the SD Flash file paths.

3. Do a check on the equipment parameters. See Check equipment parameters.

4. Update the firmware. See Update the firmware.

5. Start the equipment after a firmware update. See Start the equipment after a firmware update.
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10.4.1 Install the software to upload the firmware

Install the software
1. Unzip the file ‘sdflash.zip' to the default path of D:\sdflash.

2. Run the program SDFlash.exe.

3. Select File > Open Project.

4. Select the ‘F2812SerialFlash.sdp' project from the ‘sdflash' directory.

5. If you opened the program for the fist time, select the correct Emulator Address/ID.

6. Go to File > Exit.

7. Click Save.

Check the port settings
1. Go to Start>Control Panel>System>Hardware tab>Device Manager>Ports>USB Serial Port.

2. Right-click on USB Serial Port.

3. Select Properties.

4. Select the tab Port Settings.

5. In the Advanced Settings for COM window, do as follows:

▪ Make sure that the COM Port Number is correct. Select the correct Emulator Address/ID (see earlier in this
procedure)

▪ Change Receive (Bytes) to 4096

▪ Change Transmit (Bytes) to 4096

▪ Change Latency Timer (msec) to 16

10.4.2 Change the SD Flash file paths

1. Go to Project > Settings.

2. In the indicated tabs, change the indicated fields to the correct file path.

Tab Field

Target
Driver

Board File

Erase Algorithm

Programming Algorithm

Verify Algorithm

3. Click OK.

Note
If you extract the zip file to a different location, see Change the SD Flash file paths.

Note
This is the same process as selecting the correct COM-port address, where C4 would equal COM 4. Refer to the
device manager of the PC to find the correct address. You can change this setting later from the Project >Settings
>Target tab>Emulator Address/ID drop down list.

Note
Follow this procedure if you extracted the zip file 'sdflash.zip' to a different location than D:\sdflash.
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10.4.3 Check equipment parameters
1. Start the configuration software tool. See Start the configuration software tool.

2. Go to the Configuration screen.

3. Go to the Identification tab.

4. Push the Read button to show the firmware details.

5. Make sure that the equipment parameters below match those of the filename of the required firmware version:

▪ Single Phase (CRE) or Tri-phase (VIS)

▪ Input Voltage: 230V range or 400V range

▪ CCR Power Rating in kVA

▪ SHVS installed or SHVS not installed.

▪ The type of control system. This is PPT unless specified.

6. Stop the configuration software tool. See Stop the configuration software tool .

7. Switch OFF the equipment. See Switch OFF the equipment .

8. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply .

10.4.4 Update the firmware

Prepare the equipment

1. Remove the lower front panel. See Generic panels

2. Remove the watch-dog jumper from the CPU PCB (EPS479). See CPU PCB (EPS479).

3. Connect the firmware update dongle (A) between the PC and the equipment.

4. Click on SDFlash.exe.

5. Do a check if F2812SerialFlash.sdp loads.

6. If not, see Install the software to upload the firmware and load the correct project.

7. Switch ON the equipment. See Operation. When the equipment is ready for the firmware upload, the HMI is blank.

8. If the HMI is not blank, see Install the software to upload the firmware and load the correct project.

Upload the firmware
1. Go to Project>Settings>Programming tab>Flash Data File field.

2. Select the correct firmware version file from the files with a *.out extension.

3. Go to Device>Flash. If asked to save changes, click yes.

4. Make sure that the Erase, Program and Verify check boxes are checked.

5. Click Start.

6. Wait until the upload is complete.

7. Close the SDFlash program.
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10.4.5 Start the equipment after a firmware update

Start the equipment again

1. Switch OFF the equipment. See Switch OFF the equipment.

2. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply.

3. Install the watch-dog jumper on the CPU PCB.

4. Switch ON the equipment. See Operation.

Check if the firmware is correctly updated
1. Make sure that the firmware data on the lower line of the main menu on the HMI is correct.

2. Start the configuration software tool. See Start the configuration software tool.

3. Go to the Configuration screen.

4. Go to the Identification tab.

5. Push the Read button to show the firmware details.

Disconnect the cable and install the front panel
1. Switch OFF the equipment. See Switch OFF the equipment.

2. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply.

3. Disconnect the firmware update dongle.

4. Install the lower front panel. See Generic panels.

5. Switch ON the equipment. See Operation.

Constant Current Regulator
Maintenance

126
Copyright ®2023—2026 ADB SAFEGATE, All Rights Reserved



11.0 PCB drawings and settings

11.1 CPU PCB (EPS479)
Figure 24: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

11.1.1 LEDs

Table 16: CPU PCB LED functions

LED Color Function

LDX1 Red The voltage for the power supply is +5V DC (generated on the PCB)

LDX2 Red The voltage is +5V DC

LDX3 Red The voltage from the power supply PCB is +12 V DC

LDX4 Red The CPU operates

LD1 Green The voltage for the power supply on the PCB is +5 V DC (generated on the PCB)

LD2 Green The voltage for the power supply on the PCB is +3.3 V DC (generated on the PCB)

LD3 Green The voltage for the powers supply on the PCB is +1.8 V DC (generated on the PCB)
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11.2 Power supply PCB (EPS480)
Figure 25: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

11.2.1 LEDs

Table 17: Power supply PCB LED functions

LED Color Function

LD1 Green The voltage for the fans, if applicable is +24 V DC (generated on the PCB)

LD2 Red The voltage of the power supply on the PCB is 12 V DC

LD3 Red The fan connected to J8 is active

LD4 Red The fan connected to J10 is active

LD5 Red The LED is red when the fan connected to J12 is active

LD6 Red The fan connected to J14 is active

LD7 Red The fan connected to J16 is active

LD8 Red The fan connected to J18 is active

LD9 Red The the input voltage after the diode bridge PT is 24 V DC (nominal)

LD10 Red The voltage of the power supply on the PCB is 20 V DC

LD11 Red The sense input line voltage is 24 V AC (nominal)

LD12 Green The voltage from the 50 kHz power supply on the PCB is 48 V DC

11.2.2 Fuses

Table 18: Power supply PCB Fuses

F1 1.6 A

F2 2.5 A
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11.3 Remote Control PCB

11.3.1 EPS495 (1597.00.300)
Figure 26: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

11.3.1.1 LEDs

Table 19: Remote control PCB LED functions

LED Color Function

LD1 Green The LED is green when the voltage of the power supply on the PCB is 12 V
DC

LD2 Green The LED is green when the voltage from the DCDC1, generated on the PCB,
is + 5 V DC insulated

LD3 Green The LED is green when the voltage from the DCDC2, generated on the PCB,
is + 5 V DC insulated

LD4 Red The LED flashes red when the U5 CPU is active

lD5 Red The LED flashes red when the U6 CPU is active

11.3.1.2 Jumper settings

Table 20: Remote control PCB jumper settings

Jumper Position Function

JP2 insert enable TX serial channel 1 termination resistance

JP3 insert enable RX serial channel 1 termination resistance

Note
Until 2022, the CRE was delivered with the EPS495 board as the remote control PCB. Since 2022, the CRE has been
delivered with the EP00047, and the EP00051 as an add-on board when Multiwire is required. The functionalities of
these boards are equivalent in most cases, with the exception of the most demanding recent ALCMS systems with a
redundant bus. For CRE units equipped with the EPS495, there are options to transition to the EP00047 (and the
EP00051 add-on if needed) when required. Please contact your ADB SAFEGATE representative for more details if
needed.
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Table 20: Remote control PCB jumper settings

Jumper Position Function

JP4 insert enable TX serial channel 2 termination resistance

JP5 insert enable RX serial channel 2 termination resistance

JP6 position 1-3 and position 2-4

1 3 5

2 4 6

ethernet channel 1: enable

position 3-5 and position 4-6

1 3 5

2 4 6

serial channel 1: enable

JP7 position 1-3 and position 2-4

1 3 5

2 4 6

ethernet channel 2: enable

position 3-5 and position 4-6

1 3 5

2 4 6

serial channel 2: enable

J15 position 2-3

3 2 1

serial channel 1: RS485 configuration

position 1-2

3 2 1

serial channel 1: RS422 configuration (not used)

Jumper Position Function

J16 position 2-3

1 2 3

serial channel 1: RS485 configuration

position 1-2

1 2 3

serial channel 1: RS422 configuration (not used)

J19 position 2-3

1

2

3

serial channel 2: RS485 configuration

position 1-2

1

2

3

serial channel 2: RS422 configuration (not used)

J20 position 2-3

1

2

3

serial channel 2: RS485 configuration

position 1-2

1

2

3

serial channel 2: RS422 configuration (not used)
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11.3.2 EP00047 and EP00051
Figure 27: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

Bus A Bus B CAN μProc

J22 120 Ohm
RS485_2_TX+ (1-2)

J32 120 Ohm
RS485_1_TX+

J3 120 Ohm CAN (1-2) J16 Boot-GND (2-3)

J26 120 Ohm
RS485_2_RX+

J36 120 Ohm
RS485_1_RX+

J25 RS485_2_RX+
(4w:2-3, 2w:1-2)

J35 RS485_1_RX+
(4w:2-3)

J28 RS485_2_RX- (4w:2-3) J38 RS485_1_RX- (4w:2-3)

J14 RS485_2 (3-5, 4-6) J13 RS485_1 (3-5, 4-6)

11.3.3 Multiwire/J-Bus Connection Scheme
Figure 28: MultiwirMultiwire/J-Bus Pin Numberinge/J-Bus Pin Numbering

Note
The table shows the standard remote control configuration for the signals. If you want another configuration, contact
ADB SAFEGATE.
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Table 21:

Factory set terminal assignments for remote control connections with multiwire and single J-Bus (Cable Set 4072.30.XXX)

Function Terminal number on 32-pole connector Relay number on Remote Control PCB

(unless indicated otherwise)

Control signals (fixed)

Step 1 - CMD 1 J1.1

Step 2 - CMD 2 J1.2

Step 3 - CMD 3 J1.3

Step 4 - CMD 4 J1.4

Step 5 - CMD 5 J1.5

ON - CMD 6 J1.6

CCR OFF from HVCS - CMD 26 J1.7

NC NC J1.8

V-OUT 48V 15 J8.1

GND 48V 17 J8.2

CM – FB (general common relay return) 8 J8.3

CM – FB (general common relay return) 7, 18, J6.4 J8.4

Feedback signals (fixed)

Step 1 9 J5.1

Step 2 10 J5.2

Step 3 11 J5.3

Step 4 12 J5.4

Step 5 13 J5.5

ON (step1,2...5) / OFF (OFF or Standby
Step0)

19 J5.6

Feedback signals (configurable via HMI): the values below are default values, for configuration options (for the options, see the
table that follows)

Disable local/remote (relay 7 for both
connections)

14 J5.7 (NC relay)

28 J5.8 (NO relay)

Open circuit - FB 16 J6.1

Overcurrent - FB 20 J6.2

Bad regulation 22 J6.3

7, 18, J8.4 J6.4 (CM)

LFD alarm (Relay 11) 23 J6.5 (NO relay)

NC NC J6.6

EFD warning - FB 24 J6.7

EFD error - FB 25 J6.8

High temperature alarm - FB 27 J7.1

Short circuit - FB 29 J7.2
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Table 21:

Factory set terminal assignments for remote control connections with multiwire and single J-Bus (Cable Set 4072.30.XXX)

Function Terminal number on 32-pole connector Relay number on Remote Control PCB

(unless indicated otherwise)

Lamp fault warning - FB 21 J7.3

(not used) NC J7.4

J-Bus interface (fixed)

RS485 Bus A GND 30 DB9.3

RS485 Bus A + 31 DB9.1

RS485 Bus A - 32 DB9.2

Table 22: Factory set terminal assignments for remote control connections with multiwire dual J-Bus (Cable Set 4072.30.182)

Function Terminal number on 32-pole
connector

Relay number on Remote Control PCB

(unless indicated otherwise)

Control signals (fixed)

Step 1 - CMD 1 J1.1

Step 2 - CMD 2 J1.2

Step 3 - CMD 3 J1.3

Step 4 - CMD 4 J1.4

Step 5 - CMD 5 J1.5

ON - CMD 6 J1.6

CCR OFF from HVCS - CMD 7 J1.7

NC 8 J1.8

V-OUT 48V 25 J8.1

GND 48V 9 J8.2

Feedback signals (fixed)

GND - FB 10 J8.3

GND - FB NC J8.4

Step 1 - FB 11 J5.1

Step 2 - FB 12 J5.2

Step 3 - FB 13 J5.3

Step 4 - FB 14 J5.4

Step 5 - FB 15 J5.5

ON (step1,2...5) / OFF (OFF or Standby
Step 0 - FB)

16 J5.6

Feedback signals (configurable via HMI):

Disable local/remote NC NC J5.7 (NC relay)

NC J5.8 (NO relay)

Open circuit - FB 17 J6.1

Overcurrent - FB 18 J6.2
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Table 22: Factory set terminal assignments for remote control connections with multiwire dual J-Bus (Cable Set 4072.30.182)

Function Terminal number on 32-pole
connector

Relay number on Remote Control PCB

(unless indicated otherwise)

Bad regulation 19 J6.3 (CM)

CM specific return for Relay 11 NC J6.4

LFD alarm (Relay 11) NC J6.5 (NO relay)

NC NC J6.6

EFD warning - FB 20 J6.7

EFD error - FB NC J6.8

High temperature alarm - FB NC J7.1

Short circuit - FB NC J7.2

Lamp fault warning - FB NC J7.3

(not used) NC J7.4

J-Bus interface (fixed)

RS485 Bus B GND 27 DB92.3

RS485 Bus B- 28 DB92.1

RS485 Data B+ 29 DB92.2

RS485 Bus A GND 30 DB9.3

RS485 Data A - 32 DB9.2

RS485 Data A + 31 DB9.1

Figure 29: MultiwirMultiwire and J-Bus Connectione and J-Bus Connection

A Equipment

B Remote control equipment

C Remote control PCB - input signals

D Remote control connector on the equipment

E Opto coupler

F 48 V DC power supply

G Isoground

H +48 V DC I Rel com
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J Remote control PCB - feedback signals

K Relays

L 24 V DC power supply

M J-Bus RS485 connection

N J-Bus RS485 interface

11.4 IGBT PCB (EPS477 / EPS 496)
Figure 30: Printed CirPrinted Circuit Boarcuit Board (PCB) EPS477 for2s Semixd (PCB) EPS477 for2s Semix

11.4.1 LEDs EPS477 for 2s Semix

Table 23: IGBT PCB LED functions

LED Color Function

LDX1 Red The voltage for the high side IGBT, generated on the PCB, is +18 V DC.

LDX2 Red The voltage for the high side IGBT, generated on the PCB, is -5 V DC.

LDX3 Red The voltage for the low side IGBT, generated on the PCB, is +18 V DC.

LDX4 Red The voltage for the low side IGBT, generated on the PCB, is -5 V DC.
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11.4.2 Printed Circuit Board (PCB) EPS496 for 3s Semix

A LDX1 - red

B LDX2 – red

C LDX3 – red

D LDX4 – red

E LDX4 - red

11.4.3 LEDs EPS477 for 1s and 2s Semix

Table 24: IGBT PCB LED functions

LED Color Function

LDX1 Red The voltage for the high side IGBT, generated on the PCB, is +18 V DC.

LDX2 Red The voltage for the high side IGBT, generated on the PCB, is -5 V DC.

LDX3 Red The voltage for the low side IGBT, generated on the PCB, is +18 V DC.

LDX4 Red The voltage for the low side IGBT, generated on the PCB, is -5 V DC.

LDX5 Red The voltage for logic IC power supply is + 5 V DC.
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11.5 Output measure PCB (EPS442)
Figure 31: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

11.5.1 LEDs

Table 25: Phase bridge PCB LED RUN light functions

LED Color Function

LD1 Red Flashes red when the CPU on the PCB is active.

11.6 Diode bridge and sensing PCB (EPS476 / EPS 507)
Figure 32: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

11.6.1 LEDs
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Table 26: LEDs - Diode bridge and sensing PCB LED functions

LED Color Function

LDX1 Red The nominal voltage for the IGBT test is 24 V DC

LDX2 Red The voltage from the power supply PCB is +5 V DC

LDX3 Red The voltage from the 50 kHz power supply on the PCB is +18 V DC

LDX4 Red The nominal voltage for the IGTBT bridge bus is 560 V DC

11.7 Interface PCB (PCB1702) (option CS)
Figure 33: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

11.7.1 Jumper J2
▪ Installed: more than one series circuit

▪ Not installed: only one series circuit

11.7.2 Connectors

Table 27: 12CS connectors

Connector Connection to Connection point Description

EPS Flat cable connection to EPS495 or EP00047 (remote control PCB)

CAN Connection to CS PCB

RJ45 Webpage configuration tool connection

KEY Flat cable connection to HMI button

SUP External and internal 24VDC power supply

Connector Connection to Connection point Description

X5 Remote control multiwire
connection

CS1RC Remote control input circuit 1

CS2RC Remote control input circuit 2

CS3RC Remote control input circuit 3

CS5RC Remote control input circuit 4
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Connector Connection to Connection point Description

CS5RC Remote control input circuit 5

CS6RC Remote control input circuit 6

CS7RC Remote control input circuit 7

CS8RC Remote control input circuit 8

CSSP0 Remote control input CS spare 0

CSSP1 Remote control input CS spare 1

SPMW3 Remote control input equipment spare 3

SPMW4 Remote control input equipment spare 4

X4 Remote control multiwire
connection

B1RC Remote control input brightness step 1

B2RC Remote control input brightness step 2

B3RC Remote control input brightness step 3

B4RC Remote control input brightness step 4

B5RC Remote control input brightness step 5

ONRC Remote control equipment ON1

SPMW1 Remote control input equipment spare 2

SPMW2 Remote control input equipment spare 1

CC Common for remote control signals

CC Common for remote control signals

VISO+ Voltage source 24 VDC, positive pole2

VISO- Voltage source 24 VDC, negative pole2

Connector Connection to Connection point Description

X3 Remote control multiwire
connection

CS1FB Feedback circuit 1

CS2FB Feedback circuit 2

CS3FB Feedback circuit 3

CS4FB Feedback circuit 4

CS5FB Feedback circuit 5

CS6FB Feedback circuit 6

CS7FB Feedback circuit 7

CS8FB Feedback circuit 8

CSE-FLT Feedback CS fault

CSESP1CS6FB Feedback CS, spare 1

CSESP2CS5FB Feedback CS, spare 2

1Equipment ON control can only occur through an external signal in the standard configuration. In specific configurations, and with
appropriate setup, the ON control can also be managed by a brightness command. For further details, please contact your ADB
SAFEGATE service representative.
2The voltage source (floating in regard to earth in this equipment) can be used as a source for the remote control signals if the positive or
negative pole is connected to CC.
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Connector Connection to Connection point Description

CSESP3CS4FB Feedback CS, spare 3

X2 Remote control multiwire
connection

J6.2 Feedback equipment, configured for ‘Over current'

J6.3 Feedback equipment, configured for ‘Open circuit'

J6.6 Feedback equipment, configured for ‘EFD ERROR L1'

J6.7 Feedback equipment, configured for ‘EFD ERROR L2'

J6.8 Feedback equipment, configurable spare J6.8

J7.1 Feedback equipment, configured for ‘HI TEMP'

J7.2NC Feedback equipment, configurable spare J7.2 NC

J7.2NO Feedback equipment, configurable spare J7.2 NO

J7.3NC Feedback equipment, configurable spare J7.3 NC

J7.3NO Feedback equipment, configurable spare J7.3 NO

CROFF Feedback equipment OFF

CRFLT Feedback equipment fault

Connector Connection to Connection point Description

X1 Remote control multiwire
connection

B1FB Feedback equipment, configurable spare J5.1

B2FB Feedback equipment, configurable spare J5.2

B3FB Feedback equipment, configurable spare J5.3

B4FB Feedback equipment, configurable spare J5.4

B5FB Feedback equipment, configurable spare J5.5

ON_FB Feedback equipment ON

J5.7NC Feedback equipment in local mode

J5.7NO Feedback equipment in remote mode

CF Common for feedback signals

CF Common for feedback signals

VISO+ Voltage source 24 VDC, positive pole1

VISO- Voltage source 24 VDC, negative pole1

11.7.3 LEDs

Table 28: LEDs that indicate the logic functionality

LED Function

D7 RV3. The LED is ON if the CPU power supply is OK

D9 The LED is ON during normal operation

D10 The LED is ON if the equipment is in configuration mode

The LED flashes during normal operation

1The voltage source (floating in regard to earth in this equipment) can be used to give a voltage feedback signal if the positive or negative
pole is connected to CF.
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Table 28: LEDs that indicate the logic functionality

LED Function

D11 The LED is ON if there is no CAN-bus activity

The LED flashes if the CAN-bus is operational

D12 The LED is ON during normal operation

D13 The LED is ON during normal operation

D25 The LED is ON if the CAN-bus voltage (isolated 5V) is OK

Table 29: LEDs that indicate the interface functionality

LED Function

D59 LED ‘CRE_ON_IN'. The LED is ON if the equipment is operational and supplies power to the output circuit

D61 LED J5.7 IN. The LED is ON if the equipment is in remote mode

D63 LED J7.1 IN. Spare LED

D64 LED to CRE LOCREM. The LED is ON if the equipment is in local mode

D65 LED to CRE REQCON. The LED is ON if the CS requests to switch on the equipment

D66 LED CSEFLT. The LED is ON if the circuit selector is faulty (CSE-FAULT)

D67 LED SP_UC1. Spare LED

D68 LED SP_UC2. Spare LED

D69 LED SP_UC3. Spare LED

D73 LED J7.2_IN, SP IN1. Spare LED

D75 LED J7.2_IN, SP IN2. Spare LED

D81 LED 5VEPS

11.8 CS PCB (PCB1619) (option CS)
Figure 34: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)
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11.8.1 Connectors

Table 30: CS connectors

Connector Connection to

J1 Flat cable to piggy with 24VDC power supply, earthing and CAN-bus

J2 Connection for the current sensor

J3 Not used

J4 Not used

11.8.2 LEDs
LED Function

D7 The LED flashes BLUE if the relay coil is not energized

The LED flashes GREEN if the relay coil is energized

The LED flashes RED or alternating BLUE/GREEN if there is a failure

The LED is OFF if the PCB is not operational

D1 The LED is ON if the PCB is operational

The LED is OFF if the PCB is not operational

11.8.3 Dip switch

Table 31: Dip switch SW1

Dip switch
setting

Function

Circuit 1 (Address 0)

Circuit 2 (Address 1)

Circuit 3 (Address 2)

Circuit 4 (Address 3)

Circuit 5 (Address 4)
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Table 31: Dip switch SW1

Dip switch
setting

Function

Circuit 6 (Address 5)

Circuit 7 (Address 6)

Circuit 8 (Address 7)

11.9 HMI SIN PCB (PCB1703) (option CS)
Figure 35: Printed CirPrinted Circuit Boarcuit Board (PCB)d (PCB)

11.9.1 Connectors
Connector Connection to

CSN 7 KEY_LED1 flat cable connection to the interface PCB (1702).

11.9.2 LEDs
LED Colour LED status Description

D1 Green ON The CS is in remote mode

D2 Red ON The CS is in local mode

D3 Green ON Circuit 1 is selected and the equipment supplies output current

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty

D4 Green ON Circuit 1 is selected and the equipment supplies output current

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty

D5 Green ON Circuit 1 is selected and the equipment supplies output current
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LED Colour LED status Description

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty

D6 Green ON Circuit 1 is selected and the equipment supplies output current

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty

D7 Green ON Circuit 1 is selected and the equipment supplies output current

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty.

D8 Green ON Circuit 1 is selected and the equipment supplies output current

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty

D9 Green ON Circuit 1 is selected and the equipment supplies output current

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty

D10 Green ON Circuit 1 is selected and the equipment supplies output current

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF or in stand-by

Flashing (interval 1 s) The CS PCB is faulty

D24 Green ON The CS and the equipment are ON

Flashing: 0.5 s ON, 2.5 s OFF The equipment is OFF

D25 Red Flashing The CS generates and alarm signal

D40 Green Flashing LRN - function

11.10 Test parameters

11.10.1 Analog channels

Table 32: Analog channels

Channel Description Value range

0 Temperature 17000 - 32000

1 Temperature 27000 - 32000

2 I bridge 100 - 2000

3 V bridge 0 - 30000

4 V in ±31000

5 Aux 1 x = 0

6 Aux 2 x = 0

Ref1 V reference 1 ± 54000

Ref2 V reference 2 ± 2800
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11.10.2 Input

Table 33: Test input parameters

Connector Function

PB0 Fan 1

PB1 If 1, the Precharge control switch is enabled

PB2 If 1, the Main control switch is enabled

PB3 Fan 2

PB4 If 0, SCO/panel is open

PB5 If 1, BUS fuse is not damaged

PF0 If 0, the overcurrent protecion is ON

PF1 If 0, the overcurrent protecion is ON

11.10.3 Output

Table 34: Test output parameters

Connector Function

PE0 0 = Main control switch enabled

PE1 0 = Precharge control switch enabled

PE2 0 = Gate H activation

PE3 1 = Fan enabled

PE4 Display font

PE5 1 = Display back lighting ON

PE6 1 = Red fault LED ON

PE7 1 = Green power LED ON

11.10.4 External input
I0 to I15: Inputs from multiwire PCB.

11.10.5 External output
O0 to O15: Outputs from multiwire PCB.

11.10.6 PIC analog channels

Table 35: PIC analog channels test

Channel Description

Div_I Number of divisions of output current

Div_V Number of divisions of output voltage

EFD Number of divisions of EFD

Phase Phase displacement between V and I (x 1000)
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12.0 Wiring Diagram
Figure 36: CRE Wiring DiagrCRE Wiring Diagramam
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13.0 Technical Data
Table 36: Technical Specifications

Rated input voltage [V] 400 V AC (± 10%) single phase

230 V AC (± 10%) single phase

Rated frequencies [Hz] 50 or 60

Current regulation limits Current regulation is guaranteed under the following conditions (± 0.1 A):

▪ Under IEC 61822:2009 environmental conditions

▪ For nominal input voltage under IEC or FAA standard conditions

▪ From full load to short circuit

Current regulation modes Two preset regulation modes:

▪ normal mode (for linear loads)

▪ inductive mode (for non-linear loads (e.g. LED loads)

Average efficiency at full load 92 to 94% depending on the size of the equipment, under nominal resistive load, nominal output
current, and nominal input voltage

Power factor at output The power factor exceeds the IEC and FAA requirements. The power factor at rated load is close
to 1 and is kept at a high level for possible operational conditions

Brightness steps 5 standard, 8 maximum, fully adjustable in 65k levels (1mA resolution)

Output current [A] 6.6

Remote control and
monitoring

▪ Multiwire:

▪ Compatible voltage: 24 VDC to 48 VDC for units without circuit selector; 24 VDC for
units with circuit selector

▪ Internal power supply: 48 VDC for units without circuit selector; 24 VDC for units with
circuit selector

▪ Single or dual J-Bus protocol over 2-wire RS485

▪ Single or dual J-Bus protocol over Ethernet IEEE 802.3

Regulation response time ▪ Less than 0.5 seconds

▪ Exceeds the requirements of IEC 61822:2009

Open circuit output voltage Less than 1.2 times the nominal output voltage (RMS)

Enclosure protection
IP2X (according to IEC60529 and required by IEC61822)1

Object falling protection: Protected from objects falling vertically or at up to 5° from vertical (per
IEC 62477-1)

OVC Rating OVC II

Protective Class of the
equipment Class I

Table 37: Output specifications

Type Rated output power
[kW]

RMS output voltage at 6.6 A
RMS output current [kV]

Insulated test on
output2 [kV]

Output overvoltage protection
25kApk

CRE
2.5 2.5 0.38 3 0.75 kVRMS, 1.4 kJ

CRE 4.0 4.0 0.60 5 1.5 kVRMS, 2.8 kJ

1The product is available with various IP ratings in addition to the standard IP2X, designed to suit diverse operational needs. Please note
that certain options may affect the outline dimensions of the product. For more information or to discuss specific requirements, please
contact your ADB SAFEGATE sales representative. Custom solutions are available upon request.
2Test condition: 50 Hz sinosoidal wave for 1 minute. The test is done without output overvoltage protections.
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Table 37: Output specifications

Type Rated output power
[kW]

RMS output voltage at 6.6 A
RMS output current [kV]

Insulated test on
output [kV]

Output overvoltage protection
25kApk

CRE 5.0 5.0 0.75 5 1.5 kVRMS, 2.8 kJ

CRE 7.5 7.5 1.13 6 2.2 kVRMS, 4.2 kJ

CRE 10 10 1.50 10 2.2 kVRMS, 4.2 kJ

CRE 15 15 2.30 12 3.0 kVRMS, 5.6 kJ

CRE 20 20 3.03 15 4.5 kVRMS, 8.4 kJ

CRE 25 25 3.80 19 5.2 kVRMS, 9-8 kJ

CRE 30 30 4.54 23 6.0 kVRMS, 11.2 kJ

Table 38: Supply earthing systems and system voltage (V)

Supply earthing systems System voltage

TN-S, TN-C, TN-CS, TT (not corner earthed) ≤ 230 V

TN-S, TT (corner earthed) ≤ 400 V

TN-C (middle point earthed) ≤ 200 V

IT (corner or not corner referenced) ≤ 230 V (TOV: 400 V)

Table 39: Prospective short-circuit current (PSCC) and residual current device (RCD)

All power ratings

Max. PSCC 6kA

Min. PSCC 1500 A

RCD type B

13.1 Applicable standards
The equipment is in accordance with these standards:

Standard Description

ICAO Aerodrome Design Manual, Part 5 paragraphs 3.2. (current edition)

FAA AC 150/5345-10 (current edition), L-828 and L-829 except for input voltage

IEC IEC 61822:2009

CENELEC EN 61822

CE certified

13.2 ElectroMagnetic Compatibility (EMC)
The equipment is designed to operate in an industrial electro-magnetic environment. The regulator complies with IEC
61822:2009, in accordance with IEC 61000-6-4 and IEC 6-6-2 (generic standard for industrial environment). The equipment is,
with adapted test levels, in accordance with IEC/TS61000-6-5, G (substation environment, location G).
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13.3 Dimensions and mass
Figure 37: The stackable cabinet (A), the small cabinet (B) and the big cabinet (CThe stackable cabinet (A), the small cabinet (B) and the big cabinet (C))

Table 40: Dimensions

Item A - 2.5 kVA (stackable) B - 2.5 kVA B - 4 to 15 kVA C - 20 to 30 kVA

X [mm] 420 420 420 520

Y [mm]1 800 550 840 840

Z [mm] 460 1300 1300 1600

Table 41: Mass

Type Net mass Crate mass Crate dimensions width x depth x
height [mm]

2.5 (rack) 95 20 600 x 1000 x 650

2.5 130 23 1200x800x1500

4 160 23 1200 x 800 x 1500

5 165 23 1200 x 800 x 1500

7.5 190 23 1200x800x 1500

10 230 23 1200 x 800 x 1500

15 260 23 1200 x 800 x 1500

20 330 40 1200 x 800 x 1850

25 380 40 1200 x 800 x 1850

30 410 40 1200 x 800 x 1850

1Depending on the type of series output connection (options).
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13.4 Protection devices
Table 42: Protection devices specifications

Equipment type
[kVA]

Equipment voltage [V] Main fuse rating [A] Manual switch type C
rating [A]

Maximum line input
current [A]

2.5 208 to 230 16 16 14.7

380 to 400 16 10 8.0

4 208 to 230 32 25 23.4

380 to 400 20 16 12.8

5 208 to 230 50 40 29.3

380 to 400 32 20 16.0

7.5 208 to 230 50 50 44.0

380 to 400 32 25 24.1

10 380 to 400 50 40 32.1

15 380 to 400 50 50 48.1

20 380 to 400 80 80 64.2

25 380 to 400 100 100 80.2

30 380 to 400 125 100 96.2

13.5 Used brightness steps
All equipments are programmed with five steps by default. You can change the number of required steps. Table 43 shows the
current values that the equipment produces at each step, depending on how many steps are programmed.

Example:

The equipment is set to five brightness steps. The default current value set for step 3 is 4.1 A.

Table 43: Current values produced at each brightness step

Brightness
step

Default current value [A]

No. of steps used

3 4 5 (default) 6 7 8

1 4.8 3.3 2.8 2.7 2.2 2.8

2 5.5 4.4 3.4 3.4 2.8 3.1

3 6.6 5.5 4.1 3.9 3.4 3.4

4 6.6 5.2 4.5 4.1 3.9

5 6.6 5.4 5.2 4.6

6 6.6 6.4 5.5

7 6.6 6.4

8 6.6

These values apply when the minimum current is 2.8 A and the maximum current is 6.6 A.
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13.6 Ambient conditions
The equipment is air-cooled with fans. Thus, the equipment must have a good airflow, especially if they operate near the
maximum temperature. The installation environment shall be rated at maximum Pollution Degree 2 and free of vibrations.

Table 44: Ambient conditions

Temperature From -20 °C up to +50 °C1

Storage temperature From -40 °C up to +70°C

Temperature humidity
for long-term storage

From 10% up to 95% RH without condensation

Altitude From 0 (sea level) up to 2000 meters

Relative humidity From 10% up to 95% RH without condensation

Relative humidity for
long-term storage

< 60%

13.7 Parts list

Part orders
Each part of the equipment has a part number. When you order parts:

▪ Always mention the part number of the ordered part

▪ Always mention serial number and type of the equipment. These are indicated on the nameplate of the equipment.

For all spare part orders, contact ADB SAFEGATE or the local representative of ADB SAFEGATE.

Recommendations
To reduce downtime during maintenance, have one or more extra equipment cabinets in stand-by at the substation. This is
especially important at major airports, which have a large amount or equipments.

Keep spare parts always in stock. For example:

▪ Fuses

▪ Lightning arrestors

▪ PCBs

13.7.1 Preventive spare parts
Item Table

Main fuse Table 45

Main contactor Table 46

Lightning arrestors Table 47

WARNING
Use only original ADB SAFEGATE spare parts. If you use other spare parts, the specific module or the equipment may be
damaged. This can also put personnel in danger.

Note
The parts list may be subject to change without prior notice. Contact ADB SAFEGATE to obtain the latest version.

1This product is certified and guaranteed to operate within a temperature range of 0°C to 50°C , as defined by IEC 61822:2009, IEC
62477-1, and IEC 61477-2. The product can also function within the temperature range of -20°C to +55°C ensuring that its core
functionalities and behavior remain consistent with the ICAO Manual 5 requirements.
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Item Table

Overvoltage protection Table 48

Capacitors Table 49

Safety switches Table 50

Fans Table 51

IGBT bridge Table 53

CPU PCB Table 52

Output measure PCB Table 54

Power supply PCB Table 55

Remote control PCB Table 56

Diode bridge PCB Table 57

IGBT PCB Table 58

Ethernet adapter Table 59

Display and keyboard Table 60

Table 45: Preventive spare parts - Main fuse

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

Fuse 16A 10X38 aM 6130.20.150 SP.011249 2 2 2

Fuse 20A 10X38 aM 6130.20.160 2

Fuse 32A 10x38 aM 6130.20.200 SP.011251 2 2 2

Fuse 50A 14x51 aM 6130.20.210 SP.011252 2 2 2 2

Fuse 80A 22x58 aM 6130.20.280 SP.011254 2

Fuse 100A 22x58 aM 6130.20.300 2

Fuse 125A 22x58 aM 6130.20.220 2

Table 46: Preventive spare parts - Main contactor

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

Contactor LC1D12B7 6148.46.030 1 1 1 1

Contactor LC1D32B7 6148.46.000 1 1 1 1 1

Contactor LC1D40B7 6148.46.010 1 1

Contactor LC1D80B7 6148.46.020 1 1 1
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Table 47: Preventive spare parts - Lightning arrestors

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

Lightning arrestor SIOV
B72232-B751-K1 6314.32.750 SP.011369 2 4 4 4 6 8 10 12 14 2 2 4 4 4

Table 48: Preventive spare parts - Overvoltage protection

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

Overvoltage protection
V480LA80BP 6314.12.286 SP.011368 1 1

Table 49: Preventive spare parts - Capacitors

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

CAP. PPA1854100KN
polypropylene film + 6322.60.240 SP.011373 2 2 2 2 2 2 2 2 2 2

CAP. RMB2104250KVR 2.5uF/
1000V 6322.60.270 2 3 3 3

Table 50: Preventive spare parts - Safety switches

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

Doorswitch EPS: 684 6150.49.060 SP.011297 3 3 3 3 3 3 20 4 4 4 3 3 3 3

Table 51: Preventive spare parts - Fans

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

CCR FAN 120x120x38 24VDC
ball bearing 7074.10.100 SP.011436 2 6 6 6
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Table 52: Preventive spare parts - CPU PCB and CPU PCB with OVP

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS479/5 CRE/VIS CPU
pcb:CS00179 rev.1.1 1597.00.000 1 1 1 1 1 1 1 1 1

EPS479e/5 CRE/VIS CPU &
OVP pcb:CS00179 rev.1.1 1597.00.030 SP.010668 1 1 1 1

EPS479/15 CRE/VIS CPU
pcb:CS00179 rev1.1 1597.00.010 1 1

EPS479/15 CRE/VIS CPU &
OVP pcb:CS00179 rev1.1 1597.00.040 SP.010669 1 1

EPS479/30 CRE/VIS CPU
pcb:CS00179 rev1.1 1597.00.020 SP1597.00.020 1 1 1

EPS479/30 CRE/VISCPU &
OVP pcb:CS00179 rev1.1 1597.00.050 SP.010670 1 1 1

Table 53: Preventive spare parts - IGBT bridge

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

Semix 202 GB 12E4s (IGBT) 6351.88.040 SP.011382 2 2 2 2 2 2 2 2 2 2 2

Semix 453 GB 12E4s (IGBT) 6351.88.060 SP.011383 2 2 2

ISOLAT.M6 0.6kV 6126.12.485 2 2 2

Semix 341D16s (Bridge
Rectifier) 6351.88.030 SP.011381 1 1 1

Table 54: Preventive spare parts - Output measure PCB

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS442/2.5 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.100 1 1 1

EPS442/5 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.110 1 1 1 1

EPS442/7.5 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.120 1 1

EPS442/10 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.130 1
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Table 54: Preventive spare parts - Output measure PCB

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS442/15 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.140 1

EPS442/20 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.150 SP.010671 1

EPS442/30 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.160 1 1

Table 55: Preventive spare parts - Power supply PCB

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS480/30 VIS pow.sup.board
PCB CS00180 rev.1.2 (6 fans,
with SHVS)

1597.00.230 1 1 1 1 1 1 1 1 1 1 1 1 1 1

Table 56: Preventive spare parts - Remote control PCB

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS495 CRE/VIS
communication board PCB
CS00190 rev. 1.21

1597.00.300 SP.010673 1 1 1 1 1 1 1 1 1 1 1 1 1 1

EP00047 Communication
Board: Spares for Single or
Dual JBUS RS485 or Single or
Dual Ethernet CCRs2

1597.00.310 SP.013108 1 1 1 1 1 1 1 1 1 1 1 1 1 1

EP00051 Communication
Board add-on: Spares for
Multiwire with or without
Single or Dual JBUS RS485 or
Single or Dual Ethernet
CCRs3

N/A SP.013109 1 1 1 1 1 1 1 1 1 1 1 1 1 1

PCB1694 CRE EPS495 SIN
(option CS) 1593.27.500 1 1 1 1 1 1 1 1 1 1 1 1 1 1

1For CCRs made before September 2022.
2For CCRs made after September 2022.
3For CCRs made after September 2022.
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Table 57: Preventive spare parts - Diode bridge PCB and diode bridge PCB with OVP

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS476/5 CRE2.5/ 7.5KVA
PCB CS00176 rev.2.0 (diode
bridge & sensing)

1597.00.401 1 1 1 1

EPS476e/5 CRE2.5/ 7.5KVA
PCB CS00176 rev.2.0 (diode
bridge & sensing + OVP)

1597.00.402 SP.010674 1 1 1 1

EPS476/5 CRE2.5KVA PCB
CS00176 230V+ rev.V2.0
(diode bridge & sensing)

1597.00.460 1 1

EPS507e CRE10/15KVA PCB
CS00202 rev.1.2 (diode
bridge & sensing + OVP)

1597.00.412 SP.010675 1 1

EPS476/30 CRE/VIS 20/
30KVA PCB CS00176 rev.2.0
(sensing, without diode
bridge)

1597.00.421 1 1 1

EPS476e/30 CRE/VIS 20/
30KVA PCB CS00176 rev.2.0
(sensing, without diode
bridge + OVP)

1597.00.422 SP.010676 1 1 1

EPS476e/5/230 CRE2.5KVA
PCB CS00176 230V+ rev.V2.0
(diode bridge & sensing +
OVP)

1597.00.462 1 1

EPS507 CRE4/7,5KVA PCB
CS00202 230V+ rev,V1,2 1597.00.470 1 1 1

EPS507e/230 CRE4/ 7,5KVA
PCB CS00202 230V+ rev.V1.2
(diode bridge & sensing +
OVP)

1597.00.472 1 1 1

Table 58: Preventive spare parts - IGBT PCB

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS477 CRE/VIS 2.5/ 15KVA
PCB CS00177 rev.1.1 (IGBT
driver)

1597.00.510 SP.010681 2 2 2 2 2 2 2 2 2 2 2

EPS496 CRE/VIS 20/ 30KVA
PCB CS00191 rev. 1.0 (IGBT
driver)

1597.00.530 SP1597.00.530 2 2 2

EPS478 CRE/VIS 2.5/ 15KVA
PCB CS00178 rev.1.0
(connection board)

1597.00.520 SP.010682 1 1 1 1 1 1 1 1 1 1 1
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Table 59: Preventive spare parts - Ethernet adapter

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

EPS542 CRE/VIS single ethernet
adapter PCB CS00230 rev.1.0 1597.00.600 1 1 1 1 1 1 1 1 1 1 1 1 1 1

EPS542 CRE/VIS double
ethernet adapter PCB CS00230
rev.1.0

1597.00.610 1 1 1 1 1 1 1 1 1 1 1 1 1 1

Table 60: Preventive spare parts - Display and keyboard

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST 2.5 4 5 7.5

CCR Keyboard Box Assy.
Monophase 4072.30.620 1 1 1 1 1 1 1 1 1 1 1 1 1

13.7.2 Corrective spare parts
Item Table

Manual switch Table 61

Main fuse housing Table 62

Line filter Table 63

Input filter Table 64

Output filter Table 65

Main transformer Table 66

Table 61: Corrective spare parts - Manual switch

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

S202-C10 6150.90.750 1

S202-C16 6150.90.530 1 1 1

S202-C20 6150.90.600 1

S202-C25 6150.90.560 1 1

S202-C40 6150.90.610 1 1

Note
Depending on the communication configuration, the use of the new spares is possible with or without an upgrade kit.
Contact ADB Safegate for more information.
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Table 61: Corrective spare parts - Manual switch

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

S202-C50 6150.90.580 1 1

S292-C80 6150.90.630 1

S292-C100 6150.90.640 1 1

Table 62: Corrective spare parts - Main fuse housing

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

Fuse housing 32 6150.90.700 1 1 1 1 1 1 1 1

Fuse housing 50 6150.90.710 1 1 1

Fuse housing 125 6150.90.720 1 1 1

Table 63: Corrective spare parts - Line filter

Description Part number New
part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

Line filter 284.003(1Ph 10A/
400V)

6115.18.090 1

MK1015 (1Ph 230V) 6115.18.120 1 1

Line filter 284.001(1Ph 20A/
400V)

6115.18.050 1 1

Line filter 284.002(2Ph 40A/
400V)

6115.18.060 1 1 1 1 1

EMK1065 (1Ph 230V) 6115.18.130 1

Line filter 284.004(2Ph 90A/
400V)

6115.18.070 1 1 1

Table 64: Corrective spare parts - Input filter

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

Toroidal inductor 750uH/15A 6166.50.350 1 1 1 1 1 1 1

Inductance 285uH/40A 6166.50.310 SP.011322 2 2 2 4 4 4 2
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Table 64: Corrective spare parts - Input filter

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

CAP. PMC1704500KVR 5uF/
700V step 20-25+

6322.60.220 SP.011372 2 3 3 3 3 2 3 3 3 3

CAP. RMB2104250KVR 2.5uF/
1000V

6322.60.270 8 8 8 8

Table 65: Corrective spare parts - Output filter

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

Toroidal inductor 750uH/15A 6166.50.350 2 2

Inductance 285uH/40A 6166.50.310 SP.011322 2 2 2 2 2 2 2 2

CAP. PMC1704500KVR 5uF/
700V step 20-25+

6322.60.220 SP.011372 1

Capacitor, 30uF 400V 6322.60.300 SP.011375 3 3 3 3 2 4 4 4 1

Induct 150uH 100A - 20-25-30
kVA

6166.50.360 4 4 4

Induct 300uH 50A - 15 kVA 6166.50.370 2

Table 66: Corrective spare parts - Main transformer

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

Transf.400Vac out:24V 6300.03.430 SP.011357 1 1 1 1 1 1 1 1 1

Transf.100VA 400V/24V- 6300.03.400 SP6300.03.400 1 1 1 1 1 1

Transf.200VA 400V/24V-6VA/
24V-194VA

6300.03.410 SP6300.03.410 1 1 1

Transf.100VA 230V/
24V-94VA/24V-6VA

6300.03.420 SP6300.03.420 1 1 1 1 1

Transf. 6VA 230V/24V 6300.03.440 1 1 1 1 1
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Table 67: Corrective spare parts - Hall sensor

Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

Hall sensor old version1 1597.00.500 1 1 1

Hall sensor new version2Inside -
big cabinet 20 to 30 kVa. Use
from firmware version rel4.27e.
PCB1628 CRE current sensor
200A

1593.21.000 1 1 1

Table 68: Corrective spare parts - CS parts

Description Part number New part
number

Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5
ST

2.5 4 5 7.5

PCB1702 CSE-M SIN Logic
MW 1593.28.300 1 1 1 1 1 1 1 1 1 1 1 1 1 1

DC-DC CONV. 18-36V/24VDC
15W SD-15B-24

6341.82.024 1 1 1 1 1 1 1 1 1 1 1 1 1 1

PSU 180-550VAC 24VDC 5A
WDR-120-24

6341.80.240 1 1 1 1 1 1 1 1 1 1 1 1 1 1

Surge arrestor cartridge
L1-PE 230V IT

6134.03.080 SP.011278 2 2 2 2 2 2 2 2 2 2 2 2 2 2

Relay Gigavac G81AB47 code
Epsilon 7784

6169.07.100 Depends on the number of series circuits

RELC CSE-M 1593.20.200 Depends on the number of series circuits

PCB1703 CSE-M HMI SIN 1593.28.400 1 1 1 1 1 1 1 1 1 1 1 1 1 1

1Shape: square Location: connected to the sensing PCB
2Shape and location: see
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Appendix A: Support
Our experienced engineers are available for support and service at all times, 24 hour/7 days a week. They are part of a
dynamic organization making sure the entire ADB SAFEGATE is committed to minimal disturbance for airport operations.

ADB SAFEGATE Support

Technical Support – Global

Customers in Europe, the Middle East, Africa and Asia Pacific are more than welcome to our
portal for technical support. Trained in all areas of system issues, troubleshooting, quality
control and technical assistance, our highly experienced Technical support specialists are
available 24 hours a day, seven days a week to provide assistance over the phone.

Europe: +32-2-722-17-11

China: +86-10-8476-0106

Middle East and Africa: +971-4-452-7575

In the Americas, we also offer live technical support.

Live Technical Support – Americas

If at any time you have a question or concern about your product, contact ADB SAFEGATE's
US-based technical support specialists, available 24 hours a day, seven days a week, to assist
you via phone.

ADB SAFEGATE Americas Technical Service & Support (US & Canada) :+1-800-545-4157

ADB SAFEGATE Americas Technical Service & Support (Canada): +1-905-631-1597

ADB SAFEGATE Americas Technical Service & Support (International): +1-614-861-1304. For
technical service press 3 and for sales support press 4.

We can also be reached via email during regular business hours.

Airfield and Gate: techservice.us@adbsafegate.com

Gate: gateservice.us@adbsafegate.com

We look forward to working with you!

Before You Call

When you have an airfield lighting or control system problem, prior to calling, please ensure
the following:

▪ Review the product's manual and troubleshooting guide.

▪ Be located with the product ready to troubleshoot.

▪ Have all necessary information available: airport code/company name, customer id
number, contact phone number/email address, product/part number.

▪ Have all necessary tools that may be needed at hand.

When calling about an issue with Safedock A-VDGS, we can serve you better if you collect the
following information before you call:

▪ Relevant information regarding the issue you are calling about, such as gate number,
flight number, aircraft type and time of the event.

▪ What, if any, actions have been taken to resolve the issue prior to the call.

▪ If available, provide a CCTV recording of the incident to aid in aligning the information
from the Safedock log file.

For more information, see www.adbsafegate.com, contact ADB SAFEGATE Support via email
at support@adbsafegate.com.
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A.1 ADB SAFEGATE Website
The ADB SAFEGATE website, www.adbsafegate.com, offers information regarding our airport solutions, products, company,
news, links, downloads, references, contacts and more.
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A.2 Recycling

A.2.1 ADB SAFEGATE Recycling
ADB SAFEGATE is fully committed to environmentally-conscious manufacturing with strict monitoring of our own processes as
well as supplier components and sub-contractor operations. ADB SAFEGATE offers a recycling program for our products to all
customers worldwide, whether or not the products were sold within the European Union (EU).

ADB SAFEGATE products and/or specific electrical and electronic component parts which are fully removed/separated from
any customer equipment and returned will be accepted for our recycling program.

All items returned must be clearly labeled as follows:

▪ For Restriction of Hazardous Substances ( RoHS)/Waste Electrical and Electronic Equipment (WEEE) Recycling

▪ Sender contact information (Name, Business Address, Phone number).

▪ Main Unit Serial Number.

ADB SAFEGATE will continue to monitor and update according for any future requirements for EU directives as and when EU
member states implement new regulations and or amendments. It is our aim to maintain our compliance plan and assist our
customers.

A.2.1.1 Local Authority Recycling
The disposal of ADB SAFEGATE products is to be made at an applicable collection point for the recycling of electrical and
electronic equipment. The correct disposal of equipment prevents any potential negative consequences for the environment
and human health, which could otherwise be caused by inappropriate waste handling. The recycling of materials helps to
conserve natural resources. For more detailed information about recycling of products, contact your local authority city office.
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